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— Instruction Manual

We hope that you find PGA Championship Golf ™ 2000 both challenging and
rewarding. Don’t expect to hit 10 under par vour first round, but as you develop

the skills on some of the world’s best golf courses, you'll soon develop a feel for the
game. We hope you enjoy many great rounds!
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— Welcome to PGA Ghampionship Golf - 2000

Thank you for purchasing PGA Championship Golf™ 2000. We are very pleased
to bring you this third addition in a great series of golf games from Sierra Sports.
We appreciate the continued support of our customers and all of the feedback that
has belped us mold the game into its current state. PGA Championship Golf™ 2000
offers many great new features that I'm sure you will enjoy, but it has also under-
gone a great deal of refinement and polishing.

Those of you who are familiar with the PGA Championship Golf™ series will be
happy to find that we have stayed true to our philosophy of making solid gameplay
a priority. The golfers are still made of polygons and still controlled in real-time as
an extension of your mouse movements. The ball physics have received significant
attention, particularly in the collisions with turf, and you’ll notice a more realistic
backup, check, or release of the ball.

You'll also notice on your very first drive that TrueSwing”™ has been modified.
Fluid movements with good pace and tempo are rewarded. The new mouse motion
captures the exhilarating feeling of a smooth golf swing, but also the frustration of a
rushed golf shot. Even with the most intimidating forced-carry, a steady, confident
swing will serve you best.

Because we realize that not everyone plays golf over the Internet, PGA
Championship Golf™ 2000 now provides enjoyable off-line play through compre-
hensive seasons. You can set up and play in a series of tournaments throughout a
season against a hundred other players and work your way to the top of the money
list.

Many of the most significant improvements to the Course Architect are under the
hood. You are freer than ever to create any course you can imagine. Better still, key
imprrovements to the detail management and terrain engine bave made it faster and
more efficient to use.

While we believe that enjoyable game play is the bighest priority, realistic and

stunning graphics make the game fun. Accordingly, we've upgraded our rendering
techniques significantly and improved all of the course and golfer graphics.
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This latest addition to the series is definitely a PGA Championship Golf™ product.
When you play PGA Championship Golf™ 2000, you play as a virtual golfer in a
three-dimensional world that models the laws of physics and the game of golf with-
out cheating. If you master the skill of the golf shot and learn to work that skill
against the course, you'll become a better golfer and have a lot of fun in the process.

Vawa b b

Vance Cook
President, Headgate Studios
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— betting Started

If PGA Championship Golf" 2000 has been successfully installed, an opening screen
will automatically appear when the CD is put into the drive. The opening screen
will contain selections that enable the game or the Course Architect to be run.

If a full install has been done, PGA Championship Golf™ 2000 can be started with-
out putting in the CD. To begin, just click on the shortcut icon in the Start Menu.
Select Programs | Sierra | PGA Championship Golf™ 2000 and then:
o Course Architect: to create or edit a custom course.
* Course Manager: to run the course manager and install, move, and
delete courses.
* Playing Golf: to run the game.

Gontext-Sensitive ”ﬂ'ﬂ is available within the interface throughout PGA
Championship Golf* 2000. This feature can be accessed by the following methods,
depending on the current mode of operation.

e From the Help Menu by selecting On Item

* By pressing the hot key [F1]

* By clicking the 7] button in the upper right corner of some windows

o By clicking the Help button in the lower right corner of some windows

After selecting context-sensitive help, click on the area of the screen in question,

Tool nﬂs are available. Simply place the cursor over an icon to sec the tool tip
message. They can be turned off using the Window Men.

— Playing Golf

Once the game application has started, press any key or click on the screen to dis-
miss the introductory movie. The interface is in Wizard format and will lead you
through the process of starting a game. The general process is as follows:
Main Men - This is the first screen to appear. This is the starting point to the
interface and used to start a game.
Play Bolf - Select between local, season, and remote games.
Game Setings - Choose the course conditions and rules to play by.
Creale PIayers - Create a player to add to the game. Choose name, clothing,
ability and other attributes for your player.
Whao’s Playing - Sclect the players who will be playing in the game.

Note: You can navigate past this entire avea by selecting Quick Start from the Main Mese.

At the end of the interface Wizard, the game will begin. Other players might take
their turns before your player but eventually you will be at the tee. The general
game play will go as follows:
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Menu Bptions - Use these options to make selections and customize the game.

Greate Gameras - Put cameras on your competitors, make multiple views of
the course, or change existing views of yourself.

Swing Gamera - The Swing Camera contains the control interface for playing
the game.

Analyze The §hot - Check the conditions and distance to the area you want
vour ball to land, and adjust the aim, club and golfer’s stance.

Swinging the Goifer (Tri-Click or TrueSwing™) - Take the shot using the
player’s control method.

Pﬁﬂ Eﬂﬂmﬂfﬂﬂsmﬂ Eﬂ” E 2”"” [Pﬂ”ﬂSﬂﬂhﬂ - In the game of golf, profes-

sional golfers are separated from the rest of us by their ability to evaluate a shot and
execute it. Evaluating a shot includes judging wind speed and direction, analyzing
the distance and elevation of the pin, considering the lie, and calculating the break
of the green. Executing that shot includes motor coordination, which can be the
most difficult part. With PGA Championship Golf™ 2000, we have created a simu-
lator that allows you to control both of these characteristics. How well your player
does depends directly on your ability ro evaluate a shot and master the swing.
Whether you are using Tri-Click or TrueSwing™, your knowledge of golf and the
accuracy of your swing is what will ultimately win the round.

— Main Menu

The Main Men is the starting point for cach game. To get back ro the Main Menu
during a game, just select Main Menu (Ctrl + M) from the Game Menu.
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Select an option by clicking on the text.

Quick Sfart - The Quick Start option will allow you to skip the setup screens
and begin playing immediately. It starts a new round using the setup
options from the last game that was played. Default players are shipped
with PGA Championship Golf™ 2000 so you can utilize Quick Start the
very first time yvou load the game.

Play Golf - Opens the Play Golf screen to choose between local, season, or
remote games. This begins a new game.

fiptions - Opens the machine Options screen to customize the settings for
rendering and sounds.

Stals - View the stats of current players and currently installed courses.

Preview - Opens the tutorial on PGA Championship Golf™ 2000. You will need
the installation disk to run the preview.

Help - Starts context sensitive help.

it - Terminate the application.

— Play Golf

You can play alone at home, with co-workers over a LAN {local arca network), join
up with friends across the country via modem, or using the World Opponent
Network (WON} and establish golfing buddies around the world. If you have the
desire to play golf, PGA Championship Golf " 2000 provides you the opportunity
to get connected.

i1

i

i
st

 loczl play

preate game ]

Click on the type of game you wish to play.

lﬂﬂﬂl P’ﬂy [Sfﬂﬂ’ﬂ Eﬂfﬂﬂﬂfﬁl" I - One or more users playing from the same

machine. Each user can control one or more playersigolfers, or play
against groups of computer players.

PGA Championship Golf ™ 2000 8

Greate Game - Brings up the Game Settings screen to begin the process of
starting a new ganie,

Practice Game - Brings up the Game Settings screen. Trying to gain some
experience without being forced to follow the fairway. Only one person
will be allowed to play. Using the entire course as a practice area or Just
hitting some balls at the driving range. Practice is recommended for those
just starting out. No score is kept, and you have a bunch of practice balls.
Just swing away and hope no one is watching,.

Besume Game - Brings up the Reswme Game screen to resume a previously saved
game or shot.

SEESIM ﬂlay {single computer) = One or more users playing on the same machine.
Fach user can control one or more players/golfers and play against groups of com-
puter players. This option will hring up the Season Selection screen to select or cre-
ate a new season.

Play 88as6n - Select a season to play. The next round in the current event will be
played. Once a season is created, use Play Season to access the next round.
If the round was saved before completing it, use the Resume Game screen
to finish playing.

Greate SEASON - Create a new season by typing the name of the season to create.
This screen is followed by the Season Settings screen where the season can
be customized.

Edit Season - Select a season to edit. This screen is followed by the Season
Settings screen where unplayed events can be changed.

Delete S£as0N - Sclect a season to delete and confirm the deletion. The season
will be permanently removed.

ﬂBﬂlﬂfB Plﬂ] lﬂwm-ﬂﬂmpﬂfﬂﬂ = Remotely connect with friends using an

Internet connection, direct modem connection, or with co-workers across a LAN.

Internet - Allows you to play with people all over the world via this free
Internet gaming system. This option will bring up the WON interface
for logging into the server, meeting up with people, and starting games
or tournaments.

IPR/LAN - Remotely connect with co-workers across a LAN {local area network)
using [PX via Microsoft’s Direct Play"™.

Modem - Remotely connect with friends using a direct modem connection via
Microsoft’s Direct Play™.

Note: Hosting and [oining a Remote Game are similar for all connection methods,

s Cancel - to go to the Main Menu screen without saving the changes.

¢ Back - (0 return to the Main Memnu screen after saving the changes.

o Next - to advance to the Game Seltings, Season Selection, or Remote Game
screer.
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— Remote Game

]?::ﬁ'lote.game; play much like local games, except that you must first establish a
connection with the other computers involved. PGA Championship Golf ™ 2000
uses the concept of a PGA Championship Golf * 2000 in order to start a remote
game. The Game Hf)sr is the player who starts the remore game, chooses the game
parameters, and waits for the other players to join.

The general outline for setting up a remote game is as follows:

1. Establish a connection.

2. The Game Host starts a game,

5 S, .

3. Other players wishing to compete in the game can then join.

4. Those who are joining then select which golfer(s) they want to use in the
game.

5. The host then selects the golfers who will actually play in the game,
then starts the game. ' )

There are two types of remote connections available in PGA Championship Golf™
mn PGA Championship Golf™ 2000:
Internet - The Warid Opponent Network [WBN} option allows vou to play with people
) all over the world via this free Internet gaming system.
Direct Play [LAN/Modem] - Remotely connect with co-workers across a LAN {local

area network]), or with friends using a direct modem connection,

”ﬂSfmg d Eﬂmﬂ - Choose to host the game using one of the connection methods
prov.ided. The Game Settings screen will be displayed followed by the Who's
Playing screen. After selecting the game settings, the game is started and other play-
ers may begin to join. The host may then monitor the players joining on the Who's
Playing screen and start the game whenever desired. I’Iayérs who have not been
sclected ro play will be removed from the game. Leaving a game at certain times can
make it impossible for the game to continue. For example, if you quit while wa.iting.
for ot‘her players to join the game, the remote game will end and any players who
have joined up to that point will be removed. On the other hand, if you leave a
game that you are hosting after all players have joined and the gamr.: has started
most types of play will allow the remaining players to continue without vou .Yn;u
will always be informed if leaving a game will cause the game to end. ‘

Jﬂlﬂlﬂg d Eﬂmg - Choose to join a game using one of the connection methods

provided. Once you have joined a game, you will be taken to the Ganze Settings
screen. You will not be allowed to change the settings and will not be allowed to
continue from this screen if you do not have the course being played. If you have
thg course and joined the game when prompted, you will then be able to select play-
er(s) from the Who's Playing screen, however, if a game is using bandicaps or you ;
will only be allowed to select player(s) who have established h;;.nclicaps or have
E}'lt?ugh points. The host will not see the player(s) you have selected until you are
finished with the Who's Plaving screen. At that pn-im, the host may elect to remove
some or all of your players from the list. The game will begin when the host is fin-
JSthI w.'ith the Who's Playing screen. If all of your players have been removed, you
may join the game in progress but you will not be playing with the initial gI’Oijl[E).
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Wﬂfﬂﬂmg d ﬁ'ﬂmﬂ = Choose to join a game using one of the connection methods
provided. Once you have joined a game, you will be taken to the Game Settings
screen. You will not be allowed to change the settings and will not be allowed to
continue from this screen if you do not have the course being played. If you joined
the game after it was started, then you will be asked if you want to watch or join
the game already in progress. Choose to watch the game.

," "ﬂ’.’ Eﬂlﬂﬂ * On-screen messages allow players to communicate with each other
during game play. Players can send text, motions, and sounds to everyone, or specif-
ic players. This is perfect for those moments when you simply must comment on
your opponent’s most recent slice into the bushes, and to give the thumbs up to
your teammates.

ﬂﬂ]ﬂ!ﬂmﬂ A Eﬂfﬂﬂ * 1f you are disconnected from your current game, you may
rejoin that same game as long as there is at least one player still in the game.
However, if you voluntarily shut down the game by clicking on Exit, then you will
not be allowed to rejoin.

To rejoin @ game:
o If the game was terminated, you must restart it. You will then
¢ asked if you wish to resume your previous game. Selecting Yes will lead
you through the process of rejoining. Selecting No will not permit you to
rejoin.
e If your remote connection was disconnected, reconnect without exiting the
game. Find the game you were playing and double-click on it.

Note: To avoid long waits between turns, players should be placed in groups no larger than
four. For example, if eight friends organized a remote game, the plavers should be organized
into tiwo groups of four or four groups of two. The scores for all players in the vemote game
are posted on the Leaderboard and players can be viewed by creating a custom camera 1o fol-

lotw that player.

— Remote [LAN/Modem]

Select Remote (LAN or Modem) from the Play Golf screen. The connection will be
made via Microsoft’s DirectPlay™, a family of connection technologies that allow
you to play over various connection types (DirectPlay is part of DirectX, which is
provided for you if your system doesn’t already have it installed).

Gonnection Mﬂﬂlﬂﬂs - If your system has the necessary components for the

DirectPlay option, the connection will be made. For example, if your system doesn’t
have a modem installed, the Modem Connection option will not work.

LAN Gonneelion - Selece this to play across a network that supports the
communications protocol, then start or join games on the Local Arca
Network. When DirectPlay searches for available games on your network,
only games that have been started by users on your same subnet will be
found. These games will be displayed on the IPX/LAN Play screen.

PGA Championship Golf ™ 2000 1



Modem Connection - Fncer che phone number of a machine to connect and
configure the modem you will use.

IFK/M” P’ay Sﬂf‘ﬂﬂﬂ * Displays the games that are available to join anc

a host to start a new game. The available game list will refresh periodically,

Start Game - Type the name of the new game into the edit box in the upper left
portion of the screen, then click the Create butron. Other players will see
the newly created game and will be able to join it.

Join Bame - Double-click the name of a game to join, If the game has already
started, then choose to join the game when prompted.

Waleh Game - Double-click the name of a game that has already started, and
then choose the game to watch when prompted.

| allows

Note: Hosting and Joining a Remote Game are similar for all connection methods.

lﬂ” ’ﬂﬂﬂllaﬁﬂﬂ - You can install the game on a server connected to the LAN.
This will reduce the disk space required on your machine and increase the perform-
ance compared to running from the CD.
Requirements - Make sure you have at least 650 MB available on the server.
Gopy Gourses - Copy the contents of the Courses CD to a directory on the server,
Installation - 1nscall the game using the Com pact installation from the
Installation CD. When you are prompted to put in the second CD, edit the

directory path to point at the directory on the server where the contents of
the Courses CD have been copied.

Note: If you have a course installed on a LAN. you can use the Course Manager to install

that course for all machines intending to use it. Use the Course Properiies to change the loca-
tion of the course.

— Remate finternet]

The Internet is a great resource for gamers looking for a good round of golf against
an opponent across town or across the globe. To play over the World Opponent
Network (WONJ), you will need Internet access though an online service or through
an Internet service provider (often referred to as an “ISP”). You will need to have a
working Internet SLIP/PPP connection that supports WinSock32 to play PGA
Championship Golf™ over the Internet. You should also have at least a 28K modem,
although a 56K modem is strongly recommended. Contact your ISP or online serv-
ice if you are unsure whether they provide this type of Internet access or if you have
questions regarding how to connect to the Internet. Some Internet connections can
be initiated antomatically by the World Opponent Network (WON) through
Windows; if you have problems using this method, connect to the Internet through
your ISP before attempting to play PGA Championship Golf* over the Internet.

PGA Championship Golf ™ 2000 12
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Note: For current up to date Infernet information, go to:
http://www.sierra.com/sierrasports/golf2000/

The WON Validation Screen -

When vou select Internet from the Play Golf screen, you will see your com‘pul:(_:lrl
begin {;omlecring to WON. When your machine is connected to WON, }‘;lou *;\1!1 hscc
the WON login screen, Here you should enter a user name and password, w_ Q;;ON
you will use when you play PGA Championship E:}olf' and othcr games over :
(If you have alrcady played another game over WON, you can use the same user
name and password that you used for that game.)

¢ Click Login from the WON validation screen to begin.
e Select New Account if you have never logged on before.
e Enter a Member Name and Password.

e Exit to return to the Play Golf screen.

The WON Gathering Place -

3 i : “an se s or players and host or
In the WON Gathering Place, you can send messages to other pla\yer joagon
join a game. The Gathering Place is divided into rooms and you can enter the room
by double clicking on them or selecting the Join Room button.

"lﬂ Wﬂ" "ﬂﬂms - There is a room for cach available course, and many other

user created rooms,

Gourse RBBMS - There is a room dedicated to each of the provided courses.

You can enter rooms which are using a course that you do not have -
installed on your machine, but you will not be able to play a game on that
course withour first installing it.

Available Games -

When vou have entered a room, you will see all of the players who are in thlc room
with you, as well as any games that have been started. The room will refresh peri-
odically.

Start Game - Click the Create Game button, then choose a name -.m(_:l select
derails about the game, such as how many players you will Ial]m‘v
to join. Once the game has been created, you can cither wait for
players to join your game or invite othcr.p!aycrs in the room .rf)
join. When at least one other player has joined your game, glluk
Start Game to begin the game. The game will start automatically
if the maximum number of players that you chose to allow to
play have joined your game.

J0ifl GAME - Select the one vou want to join and click the Join Game button.

The Game Host can then accept or decline your request to ]01{11
the game, or if you are a late comer, you will be able to join the
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game already in progress but will not be playing with other
players. If the game has already started, then choose to join the
game when prompted.

Wateh Bame - Sclect a game that has already started and click the Join Game
button. Choose to watch the game when prompted.

Hosting and joining a remote game are similar for all connection methods.

Nl:?le.' More details abous WON and the Gathering Place are available through the WON
online belp feature (requires a Web browser to view) or the WON web site {rnotwon ?xe:z) If
yout encounter problems connecting to WON or playing a game, try the sugrgcs;.io;zs in ’rhc’ .
online WON help or contact technical support. . )

—Remote Message

PG‘A Championship Golf™ 2000 provides on-screen messages for remote games,
which allow vou to communicate with other players in the game without cluttering
up vour screen with a message window.

To send a message, press t?ll‘hel‘ F5, F6, F7, F8, F9, F10, or F11 keys, type vour
message in the space provided, select a motion and sound you want your golfer to
perform, then click Send. Each of these function keys saves the last n.lessagé SO you
can easily resend the same message later. You can choose an individual plaver to
send to, or broadcast your message to everyone in the game. If multiple p]e;.y'crs are
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playing from the same computer, you can select which of the players will respond.
The message you send will appear on your screen and the screen of every player
who receives the message.

You can pre-select messages for your function keys by pressing Save instead of
Send. The next time you open the message, it will default to the last saved message.
For example, you could setup the F8 key to broadcast an excited sound and motion,
and then always use the F8 key when responding to excellent shots.

You may send a “Hurry up” message to all players by pressing the F12 key. This
sends the message “Hurry up” to all players in the game and plays one of the
heckler comments.

All of the function key messages are available through the Remote Menu in the
Menu Options. It has entries for all seven regular message keys F5-F11, F12 (Hurry
Up}, and Clear Messages (Delete).

—_kame Settings

PGA Championship Golf™ 2000 allows you to customize a game in several ways.
You will get to choose a course and its conditions, number of holes to play, the rules
for the round, and what type of play to use. To adjust settings for the round, select
Play Golf from the Main Menu screen, and then create a local game from the Play
Golf screen.,

At g Click on the iabs to view the selected seffings.

a e Game Options - Set the rules to follow for
this round.

o Type of Play - Select a type of play for this
round.

s Course - Select a course to play, if the course
name is Untknoton, you do not have the
selected course and cannot continue from this
screen.

s Conditions - Choose the course conditions to
play in. If Vary Conditions is selected from the
General Options screen, the conditions will be
automatically varied per round.

e Cancel - to go to the Main Menu screen with
out saving the changes.

e Back - to return to the Play Golf screen.

e Next - to advance to the Who's Playing screen.
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—bourses

Select a course to play from the course list on the Garme Settings screen under the
Course tab.
Select Eourse - Shows a list of installed courses. Select a course to play on the
next round.
Gourse Manager - Brings u p the Course Manager to install, move, or delete
courses. '
Fﬂlﬂ"ﬂ Eﬁf - Displays a written description of the course and the special features
it includes.
UHHPSE_ ﬂlﬂf‘ - Displays a short video that provides a look at the clourse,
highlighting its special characteristics.

-YOU 9 r T ~ < o1 J
can create your own courses using the Course Architect or download courses
that have been made by other players.

. S - g4 AL i
Note: Add-on courses are available through software retailers and the Course Architect. The
nare of the add-on course will appear in this screen once the Course M anager mnstalls it

PGA Ghampionship Golf * 2000 comes with thirteen
ready-made courses.

y L ﬂﬂ};ﬂ.f Bll"ffﬂ!iff {in northwest England) - Since its founding in 1889 near
averpool in northwest England, the Roval Birkd: f club has g
golf’s truly legendary coursge& Sgee;)cd il{ rradi.tli\(iwﬂei{goul ﬁlﬂl’;ab l'\?c‘ome- ‘T“ﬁﬂor

_ j , Royal Birkdale has hosted every
major golf event in the United Kingdom: eight Open championships, including the
most recent in 1998, two Ryder Cup Matches, the Walker Cup, the Curtis Cup, and
numerous amateur tournaments. Repeatedly ranked one of the top rwo courscs,in
the entire British Isles by Golf World, Royal Birkdale is also consistently rated
among the top ten courses on earth by many of golf’s greatest players. Royal
Blrkdale’s present course was created in 1931, and fine-tuned in sﬁccccdiné years to
incorporate advances in equipment, course design and talent. Currently, the li11k§
pI‘U\'l(!C a “challenging, but fair” test. Fach hole of the 6,940 yard, par ,70 course
esgcntlal_l}-' runs in a valley between majestic sandhills. Staying on r“hé fairway is.
demanding; bur stray off it, and Royal Birkdale’s rugged terrain towering sandhills
balclctll@l‘ll and scrub will quickly turn severely punitive. (}rante;i Royal pa‘trom :‘:\J
in 1951, the Royal Birkdale Golf club today proudly maintains its tradition of :‘igror—
ous perfection. After 100 years, Royal Birkdale still delivers unsurpassed golf to ¢

a1 e Fr- - 7 3
p(ljﬂyu s from around the world: a premier course in the land where golf was invent-
ed.

2. 5ahaleg (in Northwest Washington) « Rated one of America’s 100 greatest golf
courses by Golf Digest every year since 1979, the renowned Sahalee Country C!l:l;b
h(fs in the shadow of mighty Mt. Rainier on the Sammamish Plateau of ‘Jor?hwcsr
Wash{ngton. Sahalee, meaning “High Heavenly Ground” in the L‘.hiuool; lan.guat.rc
combines the scenic wonders of the Great Northwest, with the athletic rigorﬁk of T
world-class golf. Extremely demanding, both mentally and physically, tllt‘.C]_LIlb has
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hosted numerous tournaments over the vears, including the 1998 PGA
Championship. Offering snug fairways, artful trapping, and 6,955 ya rds of annual
bluegrass and bentgrass perfection, Sahalee challenges even the best of golfers with
rolling hills, seven lakes, and over seventy-five sand bunkers in a par 70 course.
Created by master designer Ted Robinson, past president of the Society of Golf
Architects, the Club first opened in 1969. Today, Sahalee continues to provide its
brand of superlative golf amidst the rugged beauty of the Pacific Northwest.

3. Pasaliempo (in Santa Cruse, California) * Nestled in the hills of Santa Cruse
on the rugged California coast, Pasatiempo escapes from the rising crags and the
crashing surf to reveal the majesty recognized as one of the great courses designed
by Alister Mackenzie. Well Augusta may be Mackenzie’s most famous course,
Pasatiempo, Spanish for passing of time, was his most beloved, with the sixteenth
hole his favorite in all of golf. Opened in 1929, this 6,483-yard par 71 links style
course, offers eighteen of golf’s most challenging holes. True to the rugged terrain of
the Monte Ray peninsula, Pasatiempo is not for the faint hearted. Wich it’s numer-
ous sand traps and complicated rolling greens, the berankas or deep ravines, cut
across the back nine and force the choice between heroic shots or conservative
routes, the true signature of Mackenzie’s course. Neither the competitive golfer, nor
the computer golf enthusiasts should miss the challenge of Pasatiempo.

4. Black Diamond Banch (in 1.ccanto, Florida) - Set in the rolling countryside of
Florida’s Natural Coast, Black Diamond Ranch offers 27 holes of championship
golf. Designer Tom Fazio’s famed 18-hole “Quarry” course is ranked #1 in the state
by Florida Golfer Magazine and one of the top 45 nationwide by Golf Magazine
and 65th in the world! Opened in 1987, this 7,159 vard, par 72 course is carved
out of a limestone quarry. A mix of extreme elevation changes, rolling tree-lined
fairways, native sand dunes and exceptional design features compliment Black
Diamond’s Signature holes, #13 through #17. These five challenging holes run over
and around the jagged and rocky cliffs of two rerired quarries. Vertical drops of 100
feet, large boulders, wild flowers, cliffs, and the crystal clear Black Diamond Lake
make these holes some of the most exciting to be found. A mere 15 minutes from
the Gulf of Mexico, this lush private golf course is a must for any serious computer

golfer.

5. Pete Bye Golf Club (in Bridgeport, West Virginia} - Located in a majestic, pri-
vate valley, the legendary Pete Dye Golf Club combines the spectacular terrain of
the West Virginia hills with the design genius of Pete Dye to create one of the most
exciting and memorable courses any golfer could ever hope to play. The Club -built
on the site of a 19th century mine run by the world’s largest coal company -has pre-
served the remnants of that carlier era with museum-like quality, and integrated
them into its design. Of course, there’s all the Pete Dye trademarks in the layout as
well -such as deep, pot bunkers, wide fairways, and unobstructed green approaches.
Since 1993, the private Club’s 7,166 yard, par 72 course has presented a unique,
uninterrupted experience between architect, game, and nature. The Pete Dye Club is
a premier target course, sure to challenge even the most ambitious and proficient of

golfers.

PGA Championship Golf ™ 2000 17



E. The Prince Course (in Kauai, Hawaii) = Welcome to Hawaii, and eighteen of
ﬂ1e most magnificent holes of golf on earth. Located on the island of Kauai, the
internationally renowned Prince Course straddles the striking bluffs rha=r Ilaa’d from
the s_hores pf the blue Pacific up to the island’s central headlands. (.)v.erlonkin the
scenic glorlc_s of Hanalei Bay... at one with nature... the Prince climbs upiﬁll 1%:1 s
ravines, fords waterfalls, and then careens headlong back down row:lrd« thej se;ap
Integrated with the elements, challenging in the exgreme, this 7,309 Vargi par 72. sig-
nature course was designed by Robert Trent Jones, Jr., and (Jpﬁ;’k?d in 192)0 I\‘-Jow .
rankcfl rhc'Numher One course in the entire State of Hawaii, The Prince‘— ;vith its
;til:::nmg views and superlative play - is truly the golf world’; reigning tropical para-

7. Goeur 0°Alene Resort (in northern Idaho) = America’s most beautiful resort golf
course hugs the shore of Idaho’s scenic Lake Coeur d’Alene in the rolling foothills of
the Rocky Mountains. It does more than hug the lake; the Coeur d’Alene course
actpa]ly extends info the lake, to provide one of the tr,uly unigue c}lalleﬁges (:‘fhthe
entire golf world: the planet’s only floating, moveable green. As well as itsl famous
man-made floating green, the 6,309 yard, par 71 Coeur d’Alene Resort Golf Courbse
Iealgres bent grass fairways, an over-the-water driving range, and n"lanicured gree
Designed by Scott Miller - for years the chief designer of cou,rscs “by Jack s
Nicklaus” - and opened in 1991, The Cocur d’Alene provides topnot“li olf amid
the splendor and tranquility of the rugged, untouched West. e |

.8' Jﬂ;ﬂiﬂ'ﬂ 8heals (in northwestern South Carolina] - This course was designed
hy]n"n Dickson and created using the PGA Championship Golf™ 2000 Course
Al‘LJtht‘C_L Nestled above Lake Jocassee in the foothills of the Alpp-;'l\achia:l N
]'v_imlnmms, Jocassee Shoals is a nature lover’s paradise. Rock and brush ;>11rcr0 -
pings scrve as natural hazards, and the layour is routed with great car;e amuﬁd fwo
small mountain lakes. The crowning jewel is majestic Lake Jocassee, which frames
several holes as a scenic backdrop. Despite its relatively short lengtl; from tc:c.tto ’
ﬁzzelfi,ifjlsf,;ﬁi;hoa]s offers a variety of strategic and shot-making challenges in a

. 8. Canaveral Dungs - This course was designed by Brian Silvernail and created
using the PGA Championship Golf™ 2000 Course Architect. Canaveral Dunecs is an
original design set in east Florida between the Banana River and Atlantic Or:ean\ N
The course winds though tree-lined inland holes to rolling dunes along the bca"};
Accuracy and strategic shot placement are keys to success at Canaveral Dunes ::lu‘e
to the ample number of water hazards, native trees, and palm sc'"ub.that b(JL’(:iC th
course. Enjoy the warm sun and cool ocean breexzes. ) e

10. Cabo del ﬂ;aﬂfn * This course was designed by Brian Copfer and created using
the PGA Championship Golf™ 2000 Course Architect. Located in Baja California
Sur, Skm ourside the town of La Paz near the Sea of Cortez, this conirch Lsa riv;‘r
18-hole Championship course. Laid our at over 7,000 yards: the course rmﬁ’de 'c
real challenge for low handicap golfers but is still great fun gor l-)eginncrfwith its:s‘1
numerous sand traps and colinas. Pin placement is a key to club selection as rhe‘dis—
tance into greens may vary as much as 20-40 yards. Most greens slope frorﬁ back to
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front, thus flying the pin will result in tricky downhill putts. Occasionally, prevailing
winds tend to circle the course as they come off the mountains, forcing the golfer to
think twice before making a club selection. In an effort to protect its beautiful natu-
ral surroundings, motorized carts are forbidden and numerous out-of-bounds mak-

ers line every fairway.

11. Gloucester Golf and Hunt Glub - This course was designed by Steve Opfer and
created using the PGA Championship Golf™ 2000 Course Archirect. Gloucester
Golf and Hunt Club is a fictional design by Steve Opfer created especially for PGA
2000. The course simulates golfing in the pastoral British countryside and emulates
Nick Faldo’s “Americanized” style of course design. It features plenty of rolling hills
as well as heavy brush, deep grass, firm fairways, and fast greens... each a tradition
of British golf that can bring out the hacker in even the best of champions.

12. Monterey Shores Country Glub - This course was designed by Ken McHale and
created using the PGA Championship Golf™ 2000 Course Architect. Set along the
scenic shores of the Monterey Peninsula, the spectacular Monterey Shores Country
Club offers a unique challenge in golf. This 7,227-yard Par 72 course accommo-
dates some of the PGA Tours best and most prolific golfers. The course supports
seven of its eighteen holes running perilously along the rugged peninsula coastline.
Hole number seven’s higher second green offers exquisite views over it’s sister greer,
as well as the Monterey Bay, on the double green Par 3, staged in the string of shore
line holes. The Championship Course ranks among one of the longest in the PGA
Tour and is sure to challenge even the best golfers.

13. Whisperwood Golf Blub - '1'his course was designed by Jim Dickson and created
using the PGA Championship Golf™ 2000 Course Architect, Whisperwood Golf
Club is tucked away amid the peaceful sand hills of the North Carolina piedmont.
The course was constructed in 1955 on a gently rolling, pine-covered plot of land.
Golfers will enjoy the scenic beauty of the Lumber River as it winds through the
course on its way to the Atlantic. Whisperwood offers a variety of shot-making
challenges for players of all ages and abilities. Betrer bring your “A” game for the
sixth and fifreenth holes, though; miss these island greens and your ball will be
swimming.

Note: The courses created using the Course Architect can give you an idea of what can be

built wsing it.

Gourse Gonditions

Sclect the Course Conditions tab [rom the Game Settings screen. The default course
and weather conditions provide a normal day on the course. Changing these condi-
tions allows you to change the difficulty of the game. You can view the conditions
during the game by looking in the upper left corner of the Scores screen or by right-
clicking on the sky from any view.
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There are three course conditions that are customizable:

”ﬂuﬂh lﬂ”g"’ " Adjust the length of the rough grass. Changing the length of the
rough will affect a swing out of the rough and the ball speed as it comes in
contact with the rough.

Short [freshly cuf] - 1t is easy to hit the ball ourt of short rough. The ball tends to
travel longer distances because the club and ball are not slowed by impact
with the rough. It is easy ro make good contact with the ball.

Average [an average course on an average day] - The ball tends to cravel shorter
distances than whar would be expected because the club and ball are
slowed by impact with the rough. Miss hits can be caused by the grass
interfering with a club’s alignment with the ball.

Long [moments befgre the mawers are started] - 1v is difficult to hit the ball out of
long rough. The ball tends to travel shorter distances because the club and
ball are drastically slowed by impact with the longer grass. Using one club
longer (“clubbing up™) would be a good idea in long rough. Miss hits are
frequent because the long grass exaggerates a misaligned club face.

EI’BEH ‘:ﬂm""ﬂ"s " Adjust the moisture on the green. Moisture has the grearest

effect on the green.

Wet {shortly after a rain ShOWEr] - When the ball is hit onto the green, it will lose
most of its momentum on impact. The green tends to act as a wet sponge
and will cushion the ball as it lands. Putts tend to be short because of
increased friction,

Muist [early morning deW] - The ball will loose some momentum on impact with
the green. The green will cushion some of the momentum as it gives a
little. Putts tend to be slightly shorter because of increased friction.

Normal {average green on an average day] - The ball will be slowed somewhat by
the grass. Learning to putt on normal green conditions will help vour
ability to adjust for other green conditions.

Dry [a summer afterngon] - 1 is more difficult to keep approach shots on a dry
green because of the tendency for a ball with momentum to bounce when
it hits. Putts tend to roll longer than usual because of reduced friction.

Very Dry [summer in the HESErt] - The ball will ricochet off the green at firse
impact. The ground is hard and does not give ar all. You’ll need to roll

approach shots onto the green. It will seem impossible, at times, to hit a
short putt because of decreased friction.

wmﬂ Eﬂﬂdiﬁﬂ"s = Adjust the strength of the wind. The wind will affect the |

ball
while in the air. A gusty wind can be unpredictable, which makes it hard o
play in higher winds.

Still {zero wind] - This option is good for testing swings. Turning off the wind

can help you concentrate on the swing, not the weather. This is a rare
condition in the real world,

Galm [ideal golfing canditions] - There is generally some amount of wind during

calm conditions, anywhere from zero to five miles per hour for a calm day.
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The wind rarely changes direction or gusts. The \’Tw'!lt"ld can carry the ball a
little and hopefully result in better placement. This is considered a normal
condition. | |

Breezy [summer breeze] - Anywhere from five to ten miles per hour. The wind
rarely changes directions or gusts. A tail wind can carry .thc ball a few
vards on long drives. This is considered a normal condition. ‘

Eustjf [Bon’t forget your Kite] - Quite a bit of wind for playing golf. Anywhere
from ten to twenty-five miles per hour. The wind changes dircction
frequently and will gust at times. A rail wind can carry the ball great
distances during strong gusts. This is considered an unusual condition.

Strong [batien down the hatches] - Bring plenty of balls and some gogglcs. _
Anvwhere from twenty-five to forty miles per hou_r. Thel: wind changes
direction frequently and will gust at times. The wmld wll cofnplcrciy |
destroy that perfect shot and ruin your new do. Th_ls is ;onmde;fd to be
good weather to stay inside and play PGA Championship Golf 2000.

Note: You may set the course conditions to change randomly in the General Options.
However, all conditions will be in place for the entire round or tournament.

—hame Options

The game options can be changed on the Game Settings screen. Select the rules,
play, and number of holes to play.

[} ;-cmﬁat'.gn [ penalive missed balls
] custon: 1] altowe plckug
, RIS i
muliigans

- : [ suiiden death
Tounamen

. ] allow side games ;*‘
. L_]. allow ReadyPlay™ 7] all golfers play tourrament tees
\ S use handicaps [7 alf golfers play ddeﬁdjbmy-

Click on the options ro change the settings.

BH’BS » Choose the rules to use during this round. _
Begulafion - Forces all the rules to be regulation rules. No mulligans or gimmics
will be allowed, but statistics will be calculated. Each player must pIIay at
least one round of 18 holes using Regulation rules in order to establish a
handicap.
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Gustom - Allows you to choose which of the following rules you wish to enforce
during the round. Mulligans and gimmies will be allowed, but course and
player statistics will not be calculated during the round. Players will not
receive a handicap from a round of golf if this is selected.

Aligw PIEKUPS - 1n some types of play you will be allowed to pickup vour ball
when you no longer have an opportunity to win the hole. If this rule is
selected, you will be able to pickup the ball and head on to the next hole
without holing out. This option is not used if Regulation is selected.

Penalize missed balls - A penalty stroke will not be added when a plaver misses
the ball. This option is used if Regulation is selected.

Mulligans - Choose the number of mulligans a player can take. This option is not
used if Regulation is selecred.

Gimmies - Choose the distance from a hole that you will allow players to take
gimmies. This option is not used if Regulation is selected.

P’ﬂ_l( - Choose how competitively the game will be played.

Tournamen! - Intense competition feel for those trying to gain the status of a
champion. On some courses there will be galleries of people watching the
round and announcers will give play-by-play commentary. The crowds will
cheer when you make that long putt and sigh when it misses. It creates the
feeling of being in a tournament and adds a little extra excitement to the
round.

Aliow ReadyPlay” - Allow players to go to their ball and swing whenever they
want. This option greatly accelerates game play but should be turned off
by the purists who want to force honors. Use the Camera Editor to select
which player to follow.

lise Handicaps - Require cach player to have a previously calculated Handicap
{play a round of 18 using Regulation rules.) The handicap of each player
will be used to calculate the total score and determine the winner. The
scorecard will show the handicap for each hole and the handicap for a
team will depend on the type of play.

Sudden Death - Provides a way to resolve a tied round. If a tic occurs at the end
of a round, the tied players will play an additional hole. The player with
the best score for that hole wins the entire round. If plavers tie again, then
additional holes are played until one player shoots a lower score.

Allow Side Fames - Allows players to select which side games to play by bringing
up the Side Games screen after the Game Settings screen. This option will
not be available if Skins type of play is selected.

Al goifers play tournament tBES - Force all players to start from the tournament
tees regardless of which tees the player had previously selected.
Tournament Tees are the furthest tees from the hole.

All goifers play advanced ability - Force al) players to use the advanced ability level
regardless of the Ability Level that a player may have previously selected.
Advanced ability level is the most difficult to master.
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"ﬂ’ﬂs = Choose the number of holes to play. The options include the front 9,
back 9, 18 holes, and 72 holes (for those who just can’t get tfnough
satisfaction from an eighteen-hole round). If playing in practice mode, you
can choose to go to the Driving Range, Chipping Area, Putting Green, or
any hole on the selected course.

Handicap

In general, a handicap is a number that would be subtracted from your average
score for 18 holes to achieve a net score of par for the course, For e)(ample,~j
someone with a handicap of 18 would normally shoot around 90 on a par 72 |
course. Handicaps affect your score in different ways depending on the type of play
selected.

To establish a handicap, a player must first be playing with Regulation rules scllcctcd
from Options on the Game Settings screen. Then, choose one of seven ch,;xfm.tmn
types of play: Medal, Match, Stableford, Four Ball Match, Fuqr Ball Mt.:da » Four
Ball, Stableford, and Skins. Finally, the player must complete. IS—holes in one sit-
ting. A new handicap will be generated which con's_ifiers the djfﬁcullry of the course
and the player’s score for the round. The course difficulty can be vmwegi on thc|
Scores screen during a game. The first number'is the CourseScoreVelocity and the
second number is the EffectiveCoursePar. The new handicap will be calculated
using this formula:

((RoundScore - EffectiveCoursePar) / CourseScoreVelocity)

The players final handicap will be calculared using the players last twenty handicaps
according to the following method:

Number of Handicaps Average of Lowest

1-6 1 .
7-16 {Number - 3} /2
16 - 20 Number - 10

The handicap is continually tracked and updated for eac'h player as Im?bsch‘wnr _
rounds are played. Players must have established a handjc-ilp to participate in any
game that has Use Handicap checked on Options in the Game ngﬂz;zgs screen. The
handicap that is used during the round will be adjusrgd considering the Idlfflct.lltlg' of
the course being played. The handicap that is used will be calculated using this for-
mula: )

(Handicap x CourseScoreVelocity)

—Mulligans

A mulligan is a feature available for Custom Rm’els game play in the.(r'ame Set!'sregs
screen on Options. A mulligan allows you to re-hit your last shot without perfa]ty1
Mulligans are useful for keeping a bad shot fro.m affecting your score. They can also
add to the strategy of a game if you have a limited number of mulligans.
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Select the number of mulligans for each round using the drop list.
e All - Always allow mulligans.
°1,2,4,9, 18 - Allows a limited number of mulligans per player.
® Nomne - Disable the option.

After the ball has been hit, a Mulligan button is present on the Butfon Bar (assum-
ing the option has been enabled and you still have mulligans remaining). To use a
mulligan, click the button, or select Mulligan (M key) from the Action Menu.

Remember to keep track of how may mulligans you have remaining.

Note: Statistics are not updated when mulligans are aliowed,

—Gimmies

A gimmie is a feature available for Custom Rules game play in the Game Settings
screen on Options. It allows you (if your ball is a cerrain distance from the hole) to
assume that your next shot will put the ball in the hole. This option is for cautious
players who are not absolutely sure about making short putts, or for the confident
player who wants to speed up the game play.

Select the distance from the hole to aceept gimmies using the drop list,
® 6,12, 18, 24, 30, 36 in - Allow players to take gimumies when their ball is
within the selected distance to the hole.
® None - Disable the option.

When the ball is within gimmie range, the Gimmie button is available on the Button
Bar {assuming the option has been enabled) during a round. To use a gimmie, click

the button, or select Gimmies (G key) from the Action Menu.

Note: Statistics are not updated when gimmies are allowed.

—Types of Play

PGA Championship Golf ™ 2000 offers a total of twelve different types of play to
choose from. Choose your type of play using the Type Of Play tab on the Gasme
Seitings screen. Some types of play use teams of two or four. You must select the
correct number of players on the Who's Playing screen in order to fill the teams. If
more than one team exists, you can choose which players will be teamed up togeth-
er on the Create Teams screen after the Who’s Playing screen.

The rules may seem complicated at first but will become clear after a few rounds.

Mﬂdaf ’"nﬂ or mere ﬂlﬂj{ﬂl’ SJ = This is also known as stroke play. Players

compete based on their stroke totals at the end of the round or tournament. The
player with the lowest score {stroke total} wins.
Handicap: Each player uses his or her full handicap.
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Mﬂfb‘ﬂ l fWﬂ MHYEP ] ﬂﬂlﬂ « Two players compete against each other on each

hole. The winner of the hole is the player with the fewest strokes for that hole.

There is no winner if the strokes are equal. The final score is calculated from the

number of holes won. The player with the highest score wins the round.
Handicap: The difference between the two player’s lnmdjcz_lps goes to the _pla.l_\fer
with the higher handicap {the player with the lowesg ’l?.andmap gets no handicap
strokes). The handicap is applied according to the dltFl..c..Ult}; or "ralnk' of the
hole (a player applies handicap strokes on the most difficult hole f1rst, then the
next difficuls, as would typically happen in match play-based games). The
difficulty of the hole is shown on the Scores screen in the “HCP” row.

ﬂahlﬂfﬂl'ﬂ [ﬂﬂﬂ or more ﬂlﬂj’ﬂl’S} - Players compete against each other at

each hole. Points are given for each hole as follows:

Hote Score Paints
Two or more strokes over par -3
One stroke over par -1
Par 0
One stroke under par %
Two strokes under par ' N‘
Three strokes under par 8

The player with the highest final sum wins the mund.
Handicap: Each player uses his or her full handicap.

Four Ball Medal ﬂWﬂ Mﬁ](ﬂl" fﬂﬂmS] This is also known as Best Ball. It is

the same as Medal except in teams of two. The final score for the team is the sum of
the lowest scores per hole. - _
Handicap: Fach player uses 90% of their full handicap.

Four Ball Match [two player teams; four players only] - same as March

except four players compete in teams of two on each hole. The winner of the hole is

the team with the player who had the fewest strokes. , .
Handicap: Each player takes the difference berween the lowc:ft plal}'errs handi
cap and their own handicap (the player with the lowest Ih:md1cap 1s a_':lowcd no
handicap strokes). For example, player A has a '1Q handicap, player B h;‘s 8,
player C has 2, and player D has 13. After adjusting the handicaps for Four '
Ball Match, player A has 8, player B has 6, player C has 0, & player D has 11.

Four Ball Stableford [two player t8ams] - same as Stableford except in

teams of two. The winner of the hole is the team with the player who had the most

points. _ )
Handicap: Each player uses 90% of their full handicap.
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Slfiﬂs [fWﬂ or more MHWFS] - Bach player competes against all other players

in the group on each hole. A screen appears after the Game Settings screen that
prompts for dollar amounts to be entered or bet for each hole. There are 18 text
boxes (half are grayed if playing 9-holes; the same values are repeated for each 18 if
playing 72-holes).

There are three buttons on the screen. All Same As First Hole will set all text boxes
with the same number that you enter in the first one. 1X-2X-3X First Hole Value
will automatically fill in the remaining text boxes - the first third at the same value
as number 1, the second third at double the amount, and the last third at triple the
amount. Randomize First Value will fill the text boxes with random values that are
similar to the first value,

The skin for a hole is won by the player with the fewest strokes for that hole, If any
players tie for the low score, all players are considered tied and the skin is carried
over to the next hole.

For example, using the 1X-2X-3X option, if you are playing an 18-hole round and
the initial bet is $5 per hole, then the 7th-12th holes are worth $10, and the 13th-
18th holes are worth $15, assuming no ties carry over into them. If there is a tie on
the 11th hole, then the 12th hole is worth $20. Tf there is another tie on the 12th
hole, then the 13th hole is worth $35 (the $20 carryover plus $15 for the 13th
hole). The player who has won the greatest dollar amount art the end of the round
or tournament wins the round.

Handicap: Same as Match play.

SBF HMMB "Wﬂ ﬂlﬂj(ﬂ[‘ fEﬂm&] - Players compete in teams of two with both

players tecing off together. Teams then choose which of the two balls will be played.
Both team members make the second shot from this point and choose again which
one to play. The score is calculated from the total number of strokes a team needs
to complete the round. The team with the lowest score wins,
Handicap: Each team uses 50% of the lowest handicap plus 20% of the highest
handicap from the two players on the team.

5.'.‘!' amble [fﬂ!ﬂ' ﬂlﬂj{ﬂ' fﬂﬂmﬂ - Same as a two-player scramble, but with

four players per team.
Handicap: Each team uses 25% of the lowest handicap plus 20% of the second
lowest plus 15% of the third lowest plus 10% of the highest handicap from the
four players on the team.

Best Ball Ryder Cup [two piayer teams; four players only] - viye:s

compete in teams of two with each player alternating drives at each hole. The player
that does not drive hits the second shot. The players continue to alternate until the
ball is in the cup. The winner of the hole is the team with the fewest strokes for that
hole. There is no winner if the strokes are equal. The final score is calcnlated from
the number of holes won. The team with the highest score wins the round.
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Handicap: The team with the highest number of combined handicap strokes
gets 50% of the difference between the two teams’ strokes and the u_ther team
is allowed no handicap strokes. For example, team A has a 16 hand‘lcap and
team B has a 10. After adjusting the handicap for Best Ball Ryder Cup, team A
has 3 and team B has 0.

Best Ball Greensome [two player teams; four players only] - piayers

compete in teams of two with both players tecing off at each hole. They then c.huose
which of the two balls will be plaved. The player whose ball was not Fhmen hits the
second shot and the team alternates until the ball is in the cup. The winner of the
hole is the team with the fewest strokes for that hole. There is no winner if thc—
strokes are equal. The final score is calculated from the number of holes won. The
team with the highest score wins the round. ) _ .
Handicap: The team with the highest number of combined handicap strokes
oets 40% of the difference between the two teams’ strokes and the qrher team
;5, allowed no handicap strokes. For example, team A has a 19 handicap and
team B has a 14. After adjusting the handicap for Best Ball Greensome, team A
has 2 and team B has 0.

Best Ball Bloodsome [two piayer teams; four players only] - viaye:s

compete in teams of two with both players teeing off at each hole. The opposing N

team then chooses which of the two balls will be played. The player thme hall was

not chosen hits the second shot and the team alternates unil the ball is in the cup.

The winner of the hole is the team with the fewest strokes for that hole. There is no

winner if the strokes are equal. The final score is caleulated from the number of

holes won. The team with the highest score wins the rou_nd. . N
Handicap: Same as Greensome play. The handicap for the team is th;n dwdcd
into cighteen parts. The greatest parts are used on the h:d.l’[_le:il holes f}f'st, lh.lé
difficulty of the hole is displayed on the Scores screen. l-qr cxam;?lc, if a tcamﬂ
has a 38 handicap, then it will be split into two 3’s and sixteen 2s. The two 3’s
will be used on the most difficult holes.

Note: in all types of play, ties ave bandled by Sudden Death if it is selected from the Game

’ ] hales 1o e TP LT ) aver or M1
Settings screen. Golfers play as many additional holes as necessary until one player or tear

emerges viclorious,
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— Side Games

Tllu's_ screen will follow the Game Settings screen if the Side Games option was
se e?tecl fronl ,the G_ame Options tab. It allows players to select which side games to
play. This option will not be available if Skins types of play is selected.

r Enter side game poinl values below ‘
T s [ sandties

!_:_M@ Brweest it totad !j mcles
¥ 100} ace [__:_fi polies
Ez”ﬂ areeries [710] spiasties
1___"_5] birdies dirty piss
; {:;__ﬁ wup and cowris i ongest chwes
LT maggles L0 chipin
siA% 'I'“"""'z}. baks o
o L Bseits

Enter a si‘delgame value for each item. To disable a side game, enter zero for its
valup. This is the number of points a player will receive from ,each player fof co
plermg the side game requirement. This is also the number of points each play m—-'ll
lose if another player completes the side game requirement. S e

The rcguircments for each side game is as follows:

SKinS - Goes to the winner of each hole.

Lowest Putt Tofal - Goes to the player with the lowest number of putts for the
round. -

ABE - Goes to a hole in one.

Ereenies - Goes to the player on the green and closest to the hole of a par 3

) .The player must then one or two putt it. .

Birdies - Goes to a player who scores a birdie or better.

Up and Bowns - Goes to a player who makes it up and down from anywhere
around the green, ‘ |

GOCS oa I 1 II A1 ]] na ris St I(S‘ (l o the
“aﬂgms p aye: “ul a hl 5 l Lo ba & i iste
o v ﬂ'ig k: Istance h

Sandies - Goes to a player who gets up and down from a bunker.
:::l;n:i Taken from a player who leaves a sand shot in the bunker
= Goes to a player w : ' i1 j {
o a player who makes a putt from outside the length of the flag
g;_r.‘asmss = Goes to a player who makes par after hirting into the water.
irfy Pars - Goes to a player who scores par but never hit the fairway.

Iﬂﬂﬂﬁﬂ_ﬂﬂl’ﬂs - Goes to the player who hits the longest drive that remains in the
_ fairway on par fours or fives.
Ghip InS - Goes to a player who makes a chip in.
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N38sal - Goes to the winners of these three areas:
e Front 9 - Goes to the winner of the front nine holes.
e Back 9 - Goes to the winner of the back nine holes.
e Tull Round - Goes to the winner of the round.

o Cancel to go to the Main Menu screen without saving the changes.
e Back to return to the Game Settings screen.
e Next to advance to the Who's Playing screen.

5 "
—Wha’s Playing
The Who's Playing screen is where some of the greatest names ever to play PGA

Championship Golf™ 2000 are born. It’s also where they get left in the clubhouse!
Create, edit, and delete players, then select them to join the round.

- |
Create, edit and delete players before you select them to play. There are four
buttons that allow you to manipulate the players.
Ereate List - Create a new list of computer players using the List Editor screen.
Greate PIayer - Create a new player using the Player Settings screens.
Edit - Fdit the current highlighted player or list. This button is only shown when
a player or list has been highlighted.
Delete - Asks for verification, and then deletes the highlighted player or list and
all of their statistics. Saved games will still contain the player, but they will
no longer be available for a new round. This button is only shown when a
player or list has been highlighted.

There are two list boxes in the screen, one for the Available Players and one for the
Selected Players.

Available Players - This box contains a list of players that have been created but
have not been selected to play in the next round. When a new player 1s
created an entry for that player is added to this list. The entry consists of
the player name, followed by ¢ for computer players, b for human players,
and [ for lists of players.

Selecied Players - This list box contains the selected players that will be playing
in the next round of golf. The Add and Remove buttons affect who is dis
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played in this list. When a player is added to this list, they are no longer
displayed in the Available Players list. The entry consists of the player
name, followed by ¢ for computer players, b for human players, / for lists
of players, and » for remote players.

There are two methods for moving players between the Available and Selected
Players lists.
Mouble-Glick - Double-Click directly on the name and it will change lists.
Add or Remove Buttons - Click once to highlight the name. Then use the Add or
Remove buttons. The buttons are displayed when a player’s name is high

lighted. The buttons will change depending on whether the selected player
can be removed or added.,

e Cancel - to go to the Main Menu screen without saving the changes.
* Back - to return to the Game Setting screen.
* Tee OIf - ro start the round.

Note: This is the last setup screen before the game starts. You cannot get to the Who's Playing
screen with a Quick Start game.

— Player Settings

To create a player, click on the Create Player button on the Who's Playving screen.
You will then be taken to the Player Settings screen. Select a name, and then cus-
tomize the player using the following tabs.

Player Name - Feel free to enter the name of your favorite pro then prepare to
assume their talents.

Bptions - This tab allows you to customize the player’s play options.

Player Editar - You can dress your golfer, choose a face, select hair, and choose
other accessories.

Computer Abifity - You will only get this screen if you are creating a computer
player. Use these options to customize the computer player’s ability.

e Cancel - to go to the Who's Playing screen without saving the changes.
e Finish - to go to the Who's Playing screen and save the changes to the player.

— Player Dptions

To sgleclr the player options click on the Create Player button on the Who's Playing
or highlight a player and select the Edit Player button. Select the Options tab once
the Player Setlings screen appears.
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Customize the player options by clicking on the controls.
Ability LBvel - Select the ability of this player.
Ability - This option allows you to specify the difficulty required to execute the
desired shot.

o Control Method - There are three methods of swing control available.
(The traditional Tri-Click Swing takes three mouse clicks to swing.
Interactive TrueSwing™ reads mouse movement to control the golfer’s
swing and is available in both vertical and horizontal mouse movements.
Tri-Click masters may initially find their accuracy slightly decreased as
they switch to TrueSwing™, but with a lirdle practice, the increased level
of control and the feeling of actually swinging the club will more than
make up the difference. We strongly recommend TrueSwing™.}

T8BS - There are five different tees available (the starting point on any hole.)
Glubs In Bag - There are 21 clubs available to each player; however, only 14 of
those clubs can be used at any one time - 13 clubs plus a putter. This option
allows you to select the clubs the player will carry onto the course. Each club
has specific properties associated with it that should be taken into account
when selecting the clubs.

e Suggest - This recommends the club selection for the default set of 14
clubs.,

Gaddie - Selecr the caddie settings.

o Caddie - If checked, the caddie will suggest a club at the beginning of the
player’s turn, otherwise, a driver will come up at the beginning of the
hole, the selected chip club will come up just off the green, and a putter
will come up whenever the player is on the green. If a different club s
desired, you will need to select the desired club before each shot.

« Chipping Club - You must choose the default club to use for chipping.
You can choose any of the irons as your default chip club. If you do not
have the iron in your bag, then the closest club will be used instead.

Show Grid - Tn order to better read the break of a putt or see the slope of the ter
rain, a grid can be displayed over the immediare area.
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—lees

There are five different tees available (the starting point on any hole.) Not all cours-
es are equipped with five tees; in the case thar the tee type does not exist, the player
will be placed on the tee that most closely approximates the selected tee. The five
options are:

forward - For beginning players. These tees are closest to the hole.
1adlies - For standard players. Many golf courses have ladies tees.
Amateur - For standard players. The standard middle tee position.
Pro - For advanced players. Often the same as the tournament tees.

Tournament - For advanced players. These tees are usually the farthest from the
hole or placed in the most difficult position.

Note: Selecting All golfers play tournament tees from the Game Settings screen on Options
will force all players to use the Towrnament tees regardiess of any previously selected tee.

— Player Ability

The player ability can be selected from the Player Settings screen on the Player
Options tab. There are four choices for player ability:

Basie [average 230 yard drives] - The distance and direction of the ball are scaled
to make it easy for beginners. It is harder to hit a bad shot than a good
one in this mode. This is a good place to start for younger golfers and
beginners.

standard faverage 2a0 yard drivesj - The distance and direction of the ball are
scaled to make this a good stepping-stone toward an advanced ability
level. It is still easy to hit a good shoet, but it’s just as easy to hit a bad one.

Advanced faverage 278 yard drives] - ‘1'he distance and direction of the ball are not
scaled in this oprion. This swing option should be the ultimate goal of a
computer golf master. All players in a tournament should set to this ability
level.

Gomputer - Makes this player a computer controlled player with the ability
selected above.

Note: [it many other sports titles, creating an advanced player will vesult in a player having
advanced abilities regardless of the ability possessed by the user. [n PGA Championship Golf™
2000, the advanced players have no inherent ability, which requirves you to make up the differ-
ence. But for those of you who bave not acquived the skills it takes to be advanced, we offer
basic and siandard players who do bave inberent ability that will belp you compete with the
pros.

— Player Editor

Change the visual appearance of the golfer with these controls. To select the Player
Editor, click on the Create Player button on the Who's Playing screen, or highlight
a player and select the Edit Player button, Select the Player Editor tab once the
Player Settings screen appears.
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Glick on the buttons displayed in the center of the sereen. rvis win

allow you to change the colors, textures, and styles for that part of the golfer. You
can select new textures by clicking them on the right side, or scrolling through styles
and accessories using the left and right arrows on the right side of the golfer.

Hair - Select the color of hair, and scroll through different hairstyles.

Hat - select the color of hat, and scroll through different hat styles.

Fage - Sclect the facial features you want your golfer to have.

Jop - Change the shirt pattern, and scroll through different shirt styles.

Bottom - Change the colors and apparel for the lower half of the golfer.

Irim - Change the clothing’s trim color.

Shoes - Sclect shoes for the golfer.

Male or Femalg - We think you can figure this option out for vourself,

Ball Marker - Select the color of the ball marker used exclusively on the green.
The ball marker will show the current position of the player’s ball.

Redress Per Bound - Just before each round of golf, your player will choose new
clothing to wear. After all, you can’t be caught in the same outfit twice.

Right or Left Handed - Select right or left handed clubs for the golfer to use.

— Gomputer Player:

A computer player can be created by selecting the Computer Player button in the
Ability Level section of the Player Options tab. Once the computer player option is
selected, the Computer Ability tab will appear.

To customize the computer player’s ability, adjust
these statistics as desired. For default values of
Basic, Standard, and Advanced ability, use the

“f o Ability Level check buttons in the Player Options
tab. The computer player will then play to these
new statistics.

e eistance {254 | yards
dirdng accuracy [BR03 | %
st pilts ]

Sand §aes

serambling {1334 | =

greens i regation [F350 | v

birdies per round
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Driving DiStange - The average distance that a computer player can hit the ball.
) _This value can be set anywhere from 200 to 310 yards.

DBriving ACeuragy - Set the accuracy of this player’s drives by entering the percent
of drives that reach the fairway. This value can be set anywhere from 40%
to 90%.

Average PUHs - Sct the average number of putts per hole this player will take in
arder to get the ball into the cup. This value can be set anywhere from 1.6
to 4.5 putts.

Sand §aVes - Ser the percentage of time the player will be able to save par after
landing in the sand. This value can be set anywhere from 10% to 75%.

Scrambling - Set the percentage of time the player will be able to save par with
out getting a green in regulation. This value can be set anywhere form
10% to 75%.

Regutation Greens - Set the percentage of time the player will make a green in
regulation (strokes are par - 2 when ball is on the green.) This value can be
set anywhere from 10% to 85%

Birdies Per Round - Sct the average number of birdies this golfer will make per
rourid. This value can be set anywhere from 0 to 5.5.

Average Round SEOPE - Ser the average number of strokes per round. This value
can be set anywhere from 66 to 144,

Gomputer Learning - Allow the computer player to learn after every swing. The
more the computer players play, the better they get.

Randomize - Creates a random ability for the computer player. Each consecutive
click of the Random button presents different settings.

— List Editor

Create or edit a list of computer-controlled players. This list can he used to create
large tournaments where you can compete with your favorite PGA players. Begin by
entering a name for the list you are creating in the upper left corner of the screen.

Create, edit and delete players before you select them into the list. There are three
buttons that allow you to manipulate the players,
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Greale Player - Create a new player using the Player Creation screens. All players
created here will automatically be computer players.

Fdit Player - Edit the current highlighted player. This button is only shown when
a player has been highlighred.

Delete Player - Asks for verification, and then deletes the highlighted player and
all his or her startistics. Saved games will still contain the player, but he or
she will no longer be available for a new round. This button is only shown
when a plaver has been highlighted.

There are two list boxes in the screen, one for the Available Players and one for the
Selected Players in the list.

Available Players - This box contains a list of players that have been created but
have not been selected into the list. When a new player is created, an entry
for that player is added to this list. The entry consists of the player name,
followed by ¢ for compurer players.

Seigefed Players - This list box contains the selected players that will be
contained in the list. The Add or Remove buttons affect who is displayed
in this list. When a player is added to this list, they are no longer displayed
in the Available Players list. The entry consists of the player name,
followed by ¢ for computer players.

There are two methods for moving plavers between the Available and Selected
Players lists.

Double-Gliek - Double-Click directly on the name and it will change lists.

Add or Remave Buftons - Click once to highlight the name. Then use the Add or
Remove buttons. The buttons are displayed when a player’s name is high
lighted. The buttons will change depending on whether the selected player
can be removed or added.

e Cancel - to go to the Who’s Playing screen without saving the changes.
e Finish - to create the list of players and return to the Who's Playing screen.

Note: To nove players from one list to anotber, edit the first list by removing the players in
guesiion, and then edit the second list by adding those players o ii. To share lists with others,
locate the directory named after the list in the PGA Championship Golf™ 2000/Players directo-
ry. Then copy the list to another machines PGA Championship Golf™ 2000/Players directory.

— Greate Teams

Create the teams that will play in the next round of golf. This list can be used to
move players and teams around, or auromatically group them. A group of players
will be on the same hole and see each other
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FP “"ﬂ 51'28 - Select the group size

using the combo box. Group sizes must
be a multiple of the current team size.

ﬂﬂfﬂ-ﬁl’ﬂﬂﬂmﬂ « Select one of the auto-grouping buttons.

Hamdieap - Sorts the group by handicap. Players with equal handicaps will be
randomly grouped.

8Ore - Sorts the group by average round score. Players with equal average
round scores will be randomly grouped.

Random - All players will be randomly grouped.

Mﬂﬂﬂﬂl EP ﬂﬂpﬂlﬂ = Group the players, teams, and groups in any order.

Players - Move the players by clicking on a players name in the list to highlight
it. Use the up and down buttons to move the player in the list. All players
will be shifted to make room for the player.

Teams - Move the teams by clicking on the team name in the list to highlight it.
Use the up and down buttons to move the team in the list. The entire team
will be moved to the new location. All teams will be shifted to make room
for the team.

Groups - Move the groups by clicking on the group name in the list to highlight
it. Use the up and down buttons to move the group in the list. The entire
group will be moved to the new location. All groups will be shifted to
make room for the group.

Note: All human players that are playing from the same machine will be forced to play in the
same group regardless of any grouping method used. You cannot move conmiputer players into
a group of bumans unless you increase the Group Size.

— Resume [Game/Shof]

Game files are saved as .GLF files and are located in the PGA Championship Golf™
2000\Save directory. You can double click a .GLF file directly in Explorer to launch
PGA Championskip Golf™ 2000 and start the saved game. These files can also be
opened by selecting Resuwe Game from the Play Golf screen. A window will
appear with a list of available games. Select the game to be resumed. Then press
Resume to start the saved game.

To save a game, select save from the Gante Menu. To save a shot, save the game

after the player has taken a shot, but before Continue is pressed on the Button Bar
or Action Menu.
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Note: If a player has been deleted, they will remain in saved games and will still be used by
resuming the game, You may not resume games or shots that were saved on a course that vou
do noi have.

—Season Play

A new feature added to PGA Championship Golf™ 2000 is the ability to create,
edit, and play Seasons.

Season Selection - Sclect the season to play, create, edit or delete. Season files are
saved as .GSF files and are located in the PGA Championship Goll™ 2000\
Seasons directory. Select Play Season, Create Season, Edit Season, or Delete
Season from the Play Golf screen.

Paa:;:n:::liud
Heedgate d i

The interface has the same functionality for playing, creating, editing, or deleting
unless specifically stated below.

Seasan Name - Shows the name of the season currently selected.

» Create Season - Enter the name of the season. A warning will appear if
the name is already being used. To make a copy of an existing season,
select the season and change it’s name. To create an empty season, select
the New Season list item and enter a name.

Available Seasmns List - Shows a list of all currently available seasons in the
Seasons file.
e Play Season - Select a season to play.
e Create Season - The first list item will be the New Season, an empty
season. To make a copy of an existing season, select the season and
change it’s name.
» Edit Season - Select a season to edit.
® Delete Season - Select a season to delete.
88ason Infe - Displays the currently selected season information including the
next event to be plaved.
Gomments - Displays the comments for the season.

e Create Season - Enter comments for the season.

s Edit Season - Edit comments for the season.
Gancel - to go to the Play Golf screen without saving any changes.
Play §8asan: Open to go to the Game Settings screen. Begin playing the next
round.
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Greate §6ason: Create to go to the Season Schedule screen after creating the new
scason.,

M Fieadgate Open e

Edit Season: Edit to go to the Season Schedule screen to make changes to the .
Season. r date: |

dmonth | 9]day

Delgte S5easON: Delete to go to the Play Golf screen after asking for a 5 | purse

confirmation.

Event Name - Enter a name for the event. The name will be displayed on the
— oeason Schedule |

Season Schedule screen.,

This is where the schedule for the season is created and edited. Feel free to add as Hate - Selcct the sltarting date for the event, The events will be playf:d e
many events as desired. To create a schedule or edit an existing schedule, select order of their start dates. Use the Season Schedule screen to view the order
Season Play from the Play Golf screen, of all events.

i PUrse - Select a cash value to be paid to the winners of this event. The total
purse is distributed to the final round players hased on their final standings
in the tournament. First place receives the largest share of the total purse
with each subsequent player receiving a smaller percentage of the purse
than the position before them.

'

Use the Eligibility tab to change the eligibility for the event. The eligibility will
determine if a player is allowed to play in the event. If a player is not eligible, they
cannot be added in the Who's Playing screen. At the beginning of an event, all eligi-
ble players will automatically be selected to play.

e ol

The edit anc_l remove huttons will not be shown until an item in the list is selected.
Events List - Each line is a different event that will be played in the order listed.

To change the order in which the events are played, edit the date of the events
from the Event Settings screen.

e Date - Starting date for the event,
¢ Name - Name of the event.
* Purse - Total purse for the event.

Add Event - Opens the Event Settings screen to create and add a new event.

Fdit Event - Selecting an event will bring up the Edit Event button. This opens
the Event Settings screen to edit the event,

Remove Event - Sﬁ|ccringl_an event will bring up the Delete Event button. This will
remove the event from the list after asking for a confirmation.

Player Eligibility List - Shows a list of the eligibility requirements. Each entry
consists of a qualifying event and a number of top players to take from that
event. Add up to ten requirements to the list. If a player meets any one of the
requirements, they will be eligible for the new event.
o Fvent - The name of the qualifying event. Each player must have
participated in this event prior to being eligible for the new event.
o Players - The number of players that can qualify for the new event.
These players are taken from the top of the leader board.
Add Requirement - Add the requirement that is currently selected in the Ldit
Regquirements section described below.
Remove Requirement - Remove the currently selected requirement. The
requirement is removed to the Edit Requirements section described below.
Edit Bequirements - Used to select an eligibility requirement o add to the Player
Eligibility List.

e Cancel to go to the Play Golf screen without saving any changes.
* Done to go to the Play Golf screen after saving any changes.

— Fvent Settings

Creatc orlcdlt an event in a season. Setup the rounds and eligibility. To change the
event setrings, select Add Event, or Edit Event from the Season Schedule screen.
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® Event - Select the qualifying event that will determine eligibility for the
new event, !
® Players - Select the number of players from the qualifying event that can

be eligible for the new event. These players will be taken from the top
of the leader board.,

Use the Rounds tab to change the rounds for the event. Each event can have up to
six rounds. A cut can be added after each round where the players that do not meet

the cut requirements will be removed. Each round is created using the Gane
Seitings screen.

Rounds and Guls 1ist - Selecting a name for the event to be played.
® Round Number - The round number. This is the order in which the
rounds will be played.
® Course - The course to use for this round. Tt is possible to play a
different course for each round. This is selected from the Courses tab on
Game Settings screen.
e Format - Medal play is the only type of play allowed.
¢ Holes - The number of holes that will be played. This is selected from the
Game Options tab on the Game Settings screen.
Add Round - Add a new round to the Rounds and Cuts List. Opens the Game
Settings screen to customize the round.
Add But - Select a round from the Rounds and
Cuts List. This option will add a cut after the
selected round. The Cut screen will appear
and allow the cut to be customized. At the

end of the round, all players will be cut except i players [___1]
the players that meet any one of the ¢
piay ¥ of the cut strokes betind leader |10}

requirements.
. Within Top Percentage - The top percentage of players that will be allowed
into the next round.

® Minimum Players - The minimum number of top players that will be
allowed into the next round.
* Strokes Behind the Leader - Any player that is within these strokes from
the leader will be allowed into the next round.
ﬂe{novs = Removes the current selection from the Rowunds and Cuts List.
Edlit - Opens the current selection from the Rowunds and Cuts List to be changed.

If a cut is selected, the Cut screen will appear. If a round is selected, the
Game Settings screen will appear, -
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o Cancel - to go to the Season Schedule screen without saving any changes.
e Done - to go to the Season Schedule screen after saving any changes.

— Machine Dptions

PGA Championship Golf™ 2000 will be automatically configured for ideal perform-
ance on your machine during installation. These oprions allow you to manually con-
figure PGA Championship Golf™ 2000 should you prefer to run it differently on

your machine,

To customize the game options, select Options from the Main Menu screen. This
screen will appear, giving four types of options available for customization:
General - Set general play characteristics.
SoURd - Customize individual sound events by choosing the interval of play.
GoUrse - These options can change the rendering speed and the quality of the
scene.
Golfer - These options can be adjusted to speed rendering or improve the look of
the golfer.

ﬂﬂﬂﬂmmﬂﬂﬂﬂﬂ SEfﬂﬂﬂS - When the game is started for the first time, PGA

Championship Golf™ 2000 will analyze the machine and recommend settings that
will give the best performance for the machine. After changes have been made, if
you want to return to the default settings, select this button.

e Click Cancel to ignore the settings and return.
e Click OK or Apply to accept the settings.

Note: Changing the machine setlings may increase or decrease the performance. If your per-
formance is unacceptable, use the recommended setiings or see the trouble shooting section.

—bieneral Options

All of the game options discussed in this section are available from the opening
Main Menu screen by clicking Options or during the game by selecting Options
(Ctrl + O) from the Game Menu. This opens a screen with four sections: General,
Sound, Course, and Golfer. Click General.

Ball 8ize - Adjust the ball size for easier viewing during play. This option will
increase the size of the ball, but will not change the flight characteristics of
the ball.

Confinuation Defay - Sct the number of seconds that elapse before the screen
automatically redraws for your next shot. The default is None, therefore,
you must manually continue via the Continue button in the Button Bar.

Chipping Stanee - Set the number of yards from the green at which golfers will
automatically switch to a chipping stance and use the pre-selected chipping
club.
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Varying Course Eonditions - Sclect Never to have the conditions remain as you set
them in the Game Settings screen. Selecting Sometimes or Always will
change the conditions on the course randomly at the beginning of the
_round. The conditions will not change during a round or tournament.

Melric System - The game and Course Architect will use the metric system in
displaying distances. ;

Recommended Settings - Resets all options to the settings recommended for the
current machine speed and ram requirements.

—Sound Bptions

All qu the game options discussed in this section are available from the opening
Main Menu screen by clicking Options or during the game by selecting Options
(Ctrl + O) from the Game Menu. This opens a screen with four sections; General,

Sound, Course, and Golfer. Click Sound.

Some sounds are specific to Tournaments and other to Recreation.

ANl Sounds - Master switch to turn all sounds on or off. Turning sounds off on
machines with the minimum requirements for memory results in more
resources being available for the game play

Sound EVeRts - Choose the frequency of each sound event or turn them off

completely. This allows you to decrease sound you find annoying or increase

the sounds you love to hear. These options are available on Opfio;rs from the

Garme Settings screen. Select the frequency from the drop down list, or click the
check boxes to affect these sounds:

¢ Ambient Sounds - Sprinklers, birds, and planes,

e Player Comments - First and second person comments and remarks if
Recreation is selected.

* Heckle Comments - Snide remarks from a high-strung heckler when you
delay too long and Recreation is selected.

® Music - Turn the games music on or off,

¢ T.V. Announcers - Play by play commentary by T.V. announcers if
Tournament is selecred.

® Crowd Sounds - Cheers, sighs, and the ever-famous golf clap if
Tournament is selected.

¢ Collision Sounds - Ball impact with trees and terrain.

® Swing Sounds - Swing and impact sounds.

* User !nitiated - Comments initiated by a remote player on another
machine.

Recommended SeHings - Resets all options to the setti ngs recommended for the

current machine speed and ram requirements.
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—Gourse Options

All of the game options discussed in this section are available from the opening
Main Menu screen by clicking Options or during the game by selecting Options
(Ctrl + O) from the Game Menu. This opens a screen with four sections: General,
Sound, Course, and Golfer. Click Course.

—kGolfer Dptions

All of the game options discussed in this section are available from the opening
Main Menu screen by clicking Options or during the game by selecting Options
(Ctrl + 0) from the Game Menu. This opens a screen with four sections: General,
Sound, Course, and Golfer. Click Golfer.

Dbject Detail - This setting will determine the detail of the objects to use on the
course. Objects include such things as trees, ball washers, and tee markers.
The default object size is based upon the machine speed and is set during
the installation.

Panorama Betail - This option gives you the ability to choose between different
details for the panorama (the horizon view of the course]. The panorama
settings offer Nowe, Low, and High. Using the low detail panorama can
reduce render time because memory usage is reduced.

Horizon Ditance - This option lets you select the distance to render the course
terrain. Select a distance anywhere from 350 to 750 yards. As the distance
increases, the terrain that needs to be drawn increases. This will slow the
redraw speed.

Shadow Distange - This option lets you select the distance to show shadows, or
select None to turn them off. As the distance increases, the number of
shadows that need to be drawn increases. This will slow the redraw speed.

Eourse Sizes - This option lets you change the size of permanent course data
that will remain on the hard drive. Higher numbers result in quicker initial
redraw times but take up more hard disk space.

Save Goorse Debris - The divots and discarded tees are not cleaned up every
round when this option is selected.

Recommended SeHings - Resets all options to the settings recommended for the
current machine speed and ram requirements.

Golfer Deiail - Determines the detail of the golfer on the screen (by the number of
polygons used in the rendering of the golfer model). The High option will
display a smoother, more detailed golfer, but it will rake longer to draw on
the screen. The lower options are recommended for slower machines. The
quicker your golfer can draw, the smother the swing.

Bolfer Molions - Choose the frequency of golfer motions for yourself and other

golfers. Choose from the following:
o Ambient - Sway, scratch, yawn, and wipe sweat,
e Shot Reactions - Reactions to the last swings qualiry.
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¢ Delay & Preparation - Impatient foot tapping, crouching to read the
green and checking the wind.
¢ User Initiated - Motions initiated by remote golfers on other machines.
¢ Golfer Shadow - Turn off the golfer shadow. This speeds up the golfer
redraw rate.
Recommended Seltings - Resets all options to the settings recommended for the
current machine speed and ram requirements,

— Menu Options

The pull down menus at the top of the application window provide options for
game execution, These options are only available during game play. The menus are:

PGA Championship Golf

Game  Action View ‘Window Help

Game - Contains options like saving and exiting a game.
Pragtige - Is only available in the practice areas. It allows the player to switch
between practice areas.

® Driving Range - Starts the player on the driving range of the selected
course,

¢ Putting Green - Starts the player on the practice putting green of the
selected course.

¢ Chipping Area - Starts the player on the practice chipping area of the
selecred course.

e Hole 1 - 18 - Starts the player on the hole selected.

Remate - 1s only available during remote games. It allows players to send rext,
comments and golfer motions to other players.

* Tolerate High Latency - If the game is frequently terminated due to a
slow connection, you will want to allow a higher tolerance. Select this
option to allow slow remote connections.

* Messagel (Hot Key = F3) - Opens the last messages saved in this slot.

® Message2 (Hot Key = F6) - Opens the last messages saved in this slot.

® Message3 (Hot Key = F7) - Opens the last messages saved in this slot.

* Message4 (Hot Key = F8) - Opens the last messages saved in this slot.

* Message5 (Hot Key = F9) - Opens the last messages saved in this slot.

» Message6 (Hot Key = F10) - Opens the last messages saved in this slot.

® Message7 (Hot Key = F11) - Opens the last messages saved in this slot.

¢ Hurry Up (Hot Key = F12) - Opens the hurry up message box.

¢ Clear Messages (Ilot Key = Delete) - Delete the current messages on the
SCreert,

Aetion - Provides a menu version of the game interface and all the oprions on the

Burtton Bar.

View - Provides an interface for showing alternate views. In addition to the

Swing Camera, you can open other cameras that provide alternate views of
the shot you or your opponent is taking.
Window - Provides options to save the window configuration and placement,
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— Game Menu

Choose Play Golf from the Menu Options. The Game Menu provides an interface
with the game options.

Help - Opens the on-line help manual and provides About information.

» Contents (Hot Key = F1) - Opens the on-line help manual beginning
with the Contents page.

e On Item (Hot Key = Shift + F1) - Displays the context-sensitive help
cursor. Click anywhere on the game interface to get help on that item.

« Keyword (Hot Key = Ctrl + K) - Opens the on-line help manual in key
word search mode.

e About - Displays an information box about PGA Championship Golf™
2000 and the current system’s resources.

fclion Yiew Windoy

. MainMenu.  Chistd
Optionz... CukD
Save Chl+5
Save fis... - Chil=A,
Resume. . ChikH
Delete... Lhl+D
Exit AlttFd

Main Menu [Hot Key = Birl + M] - Asks for confirmation to quit the current game,
then returns to the Main Menu screen.

[Options [Hat Key = BIrl + B] - Opens the Machine Options screen. When you are
done editing the options, you will be returned to the game.

Save [Hot Key = Gtrl + §] - Save the current game. If you have just taken a
stroke, but haven’t selected Continue from the Button Bar, then the game
will be saved as if Continue was selected.

Save As [Hot Key = Girl + A] - Save the current game. Opens a screen that allows
you to name and select a location to store the saved game. If you have just
taken a stroke but not selected Continue from the Button Bar, then the
swing will be saved as well. You can then replay the swing by resuming the
game.

Resume [Hot Key = Birl + B] - Resume a saved game or swing. Asks you for the
name of the saved game file. Note: This will end your current game.

Beleie [Hot Key = Girl + B] - Opens a window that allows you to select the name
of the saved game file to delete.

Exit [Hot Key = Alt + F4] - Asks for confirmation to exit the execution of the
application.
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— Action Menu

Choose Action from the Menu Options. The Action Mernu provides a means of
interacting with the game. It allows access to the features that create an action with-
in the game. If the Action Menu item is grayed, then it is not available in the current
game state. The Button Bar contains some of the current Action Menu items and
can be used in addition to the Action Menu. The Action Menu contains the follow-
ing items:

T —

Ghip With Club [Hot Key = BJ - Alters the golfer’s stance to one of a chipping
stance using the current club. Selecting this option again will change the
club back. You will only be allowed to chip with irons.

Biast With Glub [Hot Key = B] - Used for getting the ball our of the sand. The ball
will behave similar to the flop shot but not travel as low. Selecting this
option again will change the club back. You will only be allowed to blast
with irons.

Continwe [Hot Key = Enler] - Select this item to go to your next shot. Follow all of
the same procedures as you did for the first shot keeping in mind distance
and position changes.

Mutligan [Rot Key = M] - This item will be available if you allowed mulligans in
the Gamie Settings screen and have mulligans remaining. Select it to re-hit
the last shot.

Gimmie {Hot Key = B] - This item will be available if you allowed gimmies in the
Game Settings screen and you are within the selected distance of the cup.
Select it to hole out and move to the next tee.

Replay Shot - Select this option to admire a wonderful shot or to remind yourself
of what to avoid in the future. A sub menu will appear with replay
options. Select the option to view a replay.

Move Gamera [Hof Key = Space Bar] - Moves the view of the Swing Camera so that
the perspective changes. This is useful once you have repositioned the
golfer with the aimer arrow so you can see where your shot will be

heading. This becomes available once you have repositioned or rotated the
golfer,

Rolate To Fiag [Hot Key = Shift + B - Rotates the golfer to face the flag of the cur
rent hole.

Brap Ball [Hot Key = BJ - Choose a different location for the ball. Choosing this
option will cost you a stroke.

Find Fiag [Hot Key = K - 1f you cannot see the pin from your lie, select this option
to display an extension of the pin (flag stick).

Dispiay Grid [Hot Key = N] - This will lay down a geometrical grid over the
immediate landscape in front of the golfer. A grid is useful for showing
terrain changes and the break {slope) of a green. Select it a second time to
remove the grid.

Pick tp [Hot Key = U] - Pick up the ball and move to the next hole. This option
can be selected from the Game Settings screen and becomes available
during games to allow a player to concede the hole.

Go To Ball [Hot Key = Shift + Enter] - Move the golfer up to the ball without
rendering. 'This is useful for speeding up game play.

Pull Pin [Hot Key = PJ - Takes the pin out of the hole. Select it a second time to
put it back.

Select Glub [Hot Key + 10r Wor + #] - Brings up the golf bag and allows you to
select a club from it.
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Shot Setup {Hot Key = §] - Allows you to customize the players stance, clubface,
and ball position. _

Show Bail Tracer [Hof Key = T] - Activates a tracer trail of the ball flight to make
it easier to view the flight path.

—View Menu [Game)

Choose View from the Menu Options. The View Menu allows you to open alternate
windows, view the statistics, or the current scores,

[View, window Help = Custom Camera [Hot Key = Shift + £] - Open the
O Dudtam Camers.. SHIlteC Camera Editor screen to create a custom
L e T s catrieta:

= Tap View [Hot Key = At -+ ¥, then press ] - Shows
..&g\:ﬁp;zacn e a top view of the current hole.
Drive o ) )
Deverse Drive Note: Right-clicking in the top view provides a :’?andy
= ST i distance indicator to the golfer and to the pin. Also, the
SECIRS . iy lacation will be indicated on the main game screen by a
Stats..... . BhiftaT e

Approach View lﬂﬂf Hey = At + I}, then press A] - Shows a bird’s eye view from the
fairway looking toward the green.

Green (Kot Key = Alt + V, then press fi] - Shows a bird’s eye view of the green
looking down.

Briving View [Hot Key = At + U, then press b - Shows a bird’s eye view from
behind the tee box looking down the fairway.

Reverse Driving View [Hot Key = Alt + U, then press B] - Shows a bird’s eye view
from the middle of the fairway facing the tees.

Scores [Hot Key = Shiff + 8] - Conrains the current scores for cach player on
cach hole. The players can be sorted by hole or by total score.

Stats [Hot Key = Shift + T] - Opens the Statistics screen to view player and course
statistics.

You can have as many views open as you like, however, the more that are open, the
slower the speed of play because each one needs to redraw after cagh hole. You can
also right-click over any view window to see the terrain type and distance to t_haL
point. A small marker will show up in the top view over Fhe point that was clicked.
During a swing, the ball can be seen in each view as it sails through the air or rolls
on the green.
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Wi”du W ME"" (Eﬂﬂlﬂ ’ Before the shot, the Button Bar includes butrons such as, Drop Ball, Find Flag,

Show Grid, and Move Camera.
Brop Baif {Hot Key = B - Drop the ball in a new location.
Find Flag [Hot Key = F] - Show the flag.

Choose Window from the Menu Options. The items in the Window Menu can be
checked or unchecked. Their state is saved and resumed cach time the game is run,

[ Window Help : Show Grid [Hot Key = K] - Sh.ows a ge.ometrica]_ grid over landscape in front of the
s g‘iem:o—n';fnp.' golfer. Selecting it again will hide the grid. T
v Save Corfiguralion Move Gamera [Hot ey = Space ﬂ;ﬂ'} - Moves and rotates the view of the Swing

¥ ShowTaolTips Camera to match the golfer’s position. . ‘

. EolSoeen Pick Up [Hot Key = U] - Pick up the ball and move to the next hole. This option

¥ HebEimt becomes available during games where the type of play allows a player to

concede the hole.

Views On Top [Hot Key = Alt + W, then press V] - This will place all open views on Gimmie [Hot Key = B] - This button will appear if you allowed gimmices in the
top of the Swing Camera. Game Settings screen AND you are within the selected distance of the cup.
Save Gonfiguration (Kot Key = Alt + W, then press 8] - This saves the current open . s
status, placement, and size of all windows. This configuration will be Several changes occur to the Swing Camera and Button Bar achr a&-sHot s }:11a]§le.
restored the next time the game is run The shot yardage is indicared in the upper left region oéthe window and the Button
7 ds xum, : - igan, and Gimmie.
Shaw Taol Tips (Hot Key = Alf + W, then press I] - Turn on tool tips. Simply place Babdiailgeste lf“;md: Staetic lel’}l;‘?”b“f:"'gf;" eI
the cursor over an icon to see the tool tip message. Club distances will be Gontinge [Hof Hey = Enfer] - Click this button to g e s different
displayed when hovering over the clubs in the bag. , Replay - Click this butron to replay the last shot. Selecr from many diffcren
Full Screen [Hot Key = Alt + W, then press F] - This hides the menu options at the camera directions. o —
top of the screen. To access the menu options again, move the cursor to G To Ball lﬂ!ﬂ Hey = Sﬂlff + Enterj - MOYC the golfer up t,ﬂ the ball wit
the top of the screen and the Swing Camera will automatically shift down rendering. This is useful for speeding up REpES play. _ .
to show them. i Mulligan [Hot Key = M - This button will appear if you allowed mulligans in the
Hide Button Bar (Hot Key = Al + W, then press H] - This will hide the Butcon Bar Game Settings screen. ‘ e o
when it is not in use which will increase the view of the course through the ; Gimmie [Hot Key = E] - This button will appearlaf you allowed gimmies in he‘
Swing Camera. To access the Butron Bar, move the cursor to the lower left ! Game Settings screen AND vou are within the selected distance of the cup.
corner of the Swing Camera and click on the Options icon. i .
For a more detailed explanation of each item, see the Action Mernu.
Button Bar [Game] |
The Button Bar is available within the Swing Camera. You can access it by clicking _Eamer a fd’tﬂr

on the Options button in the lower left corner of the screen. You can keep the
Button Bar visible by de-selecting Hide Button Bar from the Window Menu. This

will cause the Button Bar to cover up part of the Swing Camera. The Button Bar
options are also available in the Action Menu,

The Camera Editor screen can be accessed by clicking on

the @ camera button in the top right corner of any open
camera, or by creating a new camera by sclecting Custom
Camera in the View Menu.

The Burron Bar presents options available during game
play, both before and after the shot. For a quick descrip-
tion of any of the buttons available, move the cursor over
the button in question for a second or two and a message
will appear that describes the button’s function.

The editor will come up with the current window settings if
editing, and the default settings if creating a wm(]n‘w.
To customize the window, change any of these settings:

PGA Championship Golf ™ 2000 48 PGA Championship Golf ™ 2000 49




Move and Retate - Customize the camera position and direction with the B4

l camera icon. Click in the square box and drag it around to change the
camera position, or click on the lens to change its direction. Click the
[. Apply button to view the changes.
Flevation - Increase or decrease the camera elevation by dragging the slider
button.
Piteh - Increase or decrease the pitch of the camera by dragging the slider
button.

Attach Gamera Jo - Sclect the player this camera should follow. If ReadyPlay™ is
selected on Options in the Game Settings screen, then you will be able to
swing your player and will not need to watch the others take their swing,

This combo box will contain the players that are allowed to be attached
to:

e Swing Camera - You will only be allowed to follow the local human

players or the furthest away in the group if there are more than
one. If there are no local human players, then you will be allowed
to follow any player.

¢ Alternate Cameras - You will be allowed to follow any player on
the course, or the furthest away in a group.

Gamera Position - Select a default camera position and direction relative to the
pin or the hole. If the camera position is relative to the player, the scene ro
the left will show a ball in the lower area and the camera position will be
shown by a small BY camera icon. If the camera position is relative to a
hole, the scene to the left will show a top view of a typical hole.

Maximum PErformance - Sclect this option to increase the frame rate performance
of the camera. All cameras that have this selected will share the average
maximum performance. Cameras that do not have this option selected will
use the remaining performance.

Default Seftings - Use the default settings for the current Camera Position.
Cancel - to return to the game without saving the changes.

Apply - to render the camera being edited and view the changes.
OK - to apply the changes and return to the game,

__Swing Camera

The Swing Camera displays the view from just behind the perspective of the golfer
as default and provides an interface for playing the game. When the Swing Camera
is created during the initial setup, the machine speed is considered in sizing the

Swing Camera. The ininal size can be adjusted in the same way a standard window
can be resized.

Note: When you exit the application, the window size and coordinates are saved and restored
during the next round if you select Save Configuration from the Window Menu.
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The game can be controlled through the game interface, most of whigh resides with-
in the Swing Camera. Swinging from this view will depend on th_e swing _method,
TrueSwing or Tri-Click. The left region of the winldow contains information abour
the player and the right portion contains information about the scenc.

Upper Left Region - This area includes the player’s name, the current number of
strokes, hole number, and par for the hole. During games of 72—holes,l the
current round is also displayed. The number to the right of'the name is
that players score. Different types of play use different scoring methodsl.
When using Medal play, a plus figure shows Fhat yOu are over par, a minus
figure shows that you are under par, and an E means you are even par.
You'll start every Medal round at even par. (Enjoy it while you can!)

Upper Right Region - This area includes icons that control the window. Icons for
editing the view or closing it all together are available here.

Camera Editar - Opens the camera editor to change the view position and type.

Maximize - Changes the size of the camera to fit exactly into the application
window.

Help - Starts context help.

Lower Left Region - This area includes buttons that can be expanded to access
specific modes of the game. The currently available actions can be found in
the options button, this will bring up the Button Bar. The _club can be
changed by selecting the club. The Shot Setup can customize the next shot.
The angle of the golfer can be changed by moving the green arrow slider
or by using the left and right arrow keys.

Lower Right Region - 1'his area shows information about the current shot hThe
distance, lie, and wind indicators can be seen here, The larger versions
provide more information but take up more room on the sereen. By
clicking on the icons, you can view and dismiss the la_rg,er versions of these
indicators. You can use this information when analyzing your shot.
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Goarse Region - This is the main area of the view which shows the fairway,
greens and golfers.

e Shift + Left Click on any point to move your golfer to that position. This
is useful for choosing a different tee position, clearing the path for
another player’s shot, or just wandering around the course.

¢ Right-Click on any point to see the distance and terrain type.

¢ Right-Click on any golfer to see their name and current score.

e Right-Click on the sky to see the current course conditions.

—Analyze the Shot

Before each swing, analyze exactly how to get to your ideal position. The ability to
analyzing a shot correctly can greatly improve your score. PGA Championship Golf
" 2000 gives you all the tools necessary to correctly analyze your next shot and
make the necessary adjustments to put the ball where you want it. A typical shot
analysis will involve the following:

Distance - The distance indicaror shows whether the current player’s path to the
hole is uphill or downbhill, the distance the ball is above or below the hole,
and the distance between the ball and the pin. Check any point on the
course by righr clicking on the position you wish to check. A distance
indicator will show you the distance and elevation to that point. Examine
the current club, and determine if the shot will require a full or partial
swing. The elevation will change the club distance. If the pin is higher, the
ball will not travel as far, if the pin is lower, the ball will travel further.

Lig - The lie indicator will show the type of terrain the ball is currently in. Some
terrain may dramatically affect the ball flight while others will not affect it
at all. Some clubs are harder to hit than others on various terrain. It may
seem impossible to hit the ball out of sand with a wood, but irons will do
the job quite nicely. Also check the area in front of the shot. If it is heavily
wooded, it may be a good idea to change directions just to get out of the
trees. If there are undesirable areas, you may want to try to carry them or
lay up. Some terrain types are more prone to miss hits Shanks, heels, and
toes can be common on some terrain if the club is not centered on the ball.

Slope of Lig - The slope of the lic is an important indicator of how the club will

strike the ball. If you have trouble seeing the slope of the terrain, use the Grid

option. You can compensate for these affects using Shot Setup.

¢ Uphill Lie - The shot path direction is going up hill. Since the golfers feet
are at different elevations, the clubface is angled up which will produce
more loft.

Downbhill Lie - The shot path direction is going down hill. The clubface

is angled down which will produce less loft.

Above Side Hill Lie - The ball is above the golfers feet. When the golfer

compensates for the elevation difference by lifting the club, the ball will

tend to draw (curve left.)

Below Side Hill Lie - The ball is below the golfers feet. When the golfer

compensates for the elevation difference by lowering the club, the ball

will tend to fade (curve right.)
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—Ghoosing a Glub

Wind - The wind indicator shows the velocity of the wind. It displays the speed
and direction relative to the view. The wind speed will vary according to
what you selected for Wind Conditions in the Game Seitings screen.
Depending on the wind direction and speed you may need to select a
different club or aim differently. The affects of the wind on the ball can be
compensated for in most cases.

Glub Selegtion - The club selection is one of the most important parts of the shot.
Evaluate the wind direction and speed, the lie, and distance to the pin. The
caddie will usually do a pretty good job at this but a seasoned golfer
should always make the final decision.

Aiming - Try to read the green using the Grid and possibly a different camera
view. Adjust for the break in a green by aiming the golfer. Check the wind
direction and speed; you may need to aim into the wind in some cases in
order to counter the drift it will have on the ball. Aim the golfer using the
left and right arrow kevs, or use the aiming slider button at the bottom of
the Swing Camera. Once the golfer direction has been changed, the
perspective can then be rotated to the new direction using Rotate View
(R key) in the Actiorn Menu or from the Button Bar.

Shat Sefup - Increase or decrease a club’s loft by changing the golfer’s stance.
You can adjust the clubface to open or closed, and the swing plane to out
side-in or inside-out. Shot Setup will then allow you to save your custom
shot types. This is an advanced feature that will allow you ultimate control
over the golfer’s swing.

It is strongly recommended that vou take your golfer to the practice areas. This way
you can learn the characteristics of each shot analysis item. You can test different
theories and adjust shortcomings. For the serious golfer, learning these techniques
will provide you with a huge advantage.

There are 21 clubs available to each player; however, only 14 of those clubs can be
used at any one time, 13 clubs plus a putter. The Chbs I Bag option on the Player
Settings screen allows you to select the clubs the player will carry onto the course.
Each club has specific properties associated with it that should be taken into
account when selecting the clubs:

ARGIE - This is the angle of the clubface and it is what gives the ball loft. The
lower the angle, the lower the ball flight.

Distance - The distance of the club is an average distance for each player. To
view the average club distance for each club, move the cursor over the club
for a few seconds and a tool tip message will appear if Tool Tips is enabled
from the Window Menu.
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The angle and distance specifications for an advanced player’s clubs are listed
below:

Club Angle Distance
D1 9.5° 275 yds
D2 12° 270 yds
2W 14° 260 yds
W 16° 250 yds
4w 18° 235 vds
SW 21° 215 yds
6W 23° 200 yds
W 257 190 yds

1 18° 235 yds
21 21° 220 yds
31 24° 205 yds
41 27° 195 yds
51 31° 185 yds
61 35° 172 yds
71 39° 160 yds
81 3° 148 yds
91 47° 135 yds
PW 51° 120 yds
SW 56° 90 yds
LW 60° 70 yds

The putter is always present in the golf bag and is usually used exclusively on the
green or around the fringes of the green. Check the other clubs you wish to have in
the player’s bag. If you accidentally select too many, you’ll receive a friendly error
message. This is a lot better than the disqualification you would experience in an
actual tournament for this rule infraction.

Caddie Suggestions - The caddie calculates distance to the pin, elevation
difference, and course conditions. The caddie will then suggest a club using
the player statistics for average club distance. If the caddie does not select
the club you desire, it can be changed easily during gameplay. Whenever
Regulation rules are selected from the Game Settings screen, and the player
is using caddie suggestions, then statistics will be kept on the average
distances hit with each club. Over time, the caddie will learn how the
player uses each club and give better suggestions.

Note: To see the player’s club statistics during game play, turn on screen tips, then place the
cursor over a club in the bag for a few seconds. A screen tip box will appear with the current
vardage.

No Gaddie Suggestions - The driver will come up at the beginning of the hole, the

default chipper when just off the green, and the putter will come up when
ever the player is on the green. If a different club is desired, you will need
to select a new club before each shot.
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—Ghanging the Glub

If you have Caddie Suggestions selected on the Player Settings screen, the most
appropriate club will automatically be placed in the golfer’s hands before each shot.
This club is displayed in the lower left corner of the Swing Camera.

T If you want to override the suggested club or if
you do not have Caddie Suggestions selected, click
the club icon in the lower left corner of the Swing
Camera to change it (vou will probably need to do
this before every shot without a caddie suggestion).
This will display vour golf bag. The golf bag will
contain the clubs that were selected when the play-
er was last edited. The average distance the club
can reach is determined by the player ability set-
ting. Choose the desired club from the bag by
clicking on it. The golf bag will disappear and the new club will appear in the lower
left hand corner. Exit the club selection mode by pressing ESC or clicking outside
the bag.

To select a club using hot keys, type W or I + (club number). Woods are selected by
typing W + # and irons are selected by typing 1 + #. If the player does not have the
selected club, then the club with the closest characteristics is chosen.

Wood hot keys are:
Dl =W+0 3W=W+3 6W =W +6
D2=W=«+1 4W =W + 4 TW =W +7

W =W4+2 SW=wWx+5

Iron hot keys are:
IT=T1T+1 6l=1+6 PW=1I+P
2l=1+2 1=1+7 SW=1+8
=1+3 81=1+8 IW =1+L
4l=1+4 91=1+9 Putter =1+ 0
5[-——[+5

For more information about which club to choose, see the section on Choosing a
Clreb, This lists the loft and advanced distance of every club.

— Drop Ball

If the ball becomes unplayable, or if you find that a shot has ended up behind an
obstruction {trees, bushes, etc.), you may need to drop the ball in order to clear
your next shot. A drop results in a one-stroke penalty unless the ball lands on a cart
path. If the ball lands out of bounds, you will be force to re-hit from the same loca-
tion and it will cost two strokes.
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Click the Drop (Hot Key = D) button. The cursor disappears and you are able to
move the golfer around on valid drop areas. The allowable drop area extends two
club lengths to either side of your existing lie, and no closer to the hole. You won’t
be allowed to drop in hazards or out of bounds. When you are in an allowable drop
area, left click and the golfer will drop the ball at that location. If the ball rolls out
of bounds again, you will have to repeat the process.

You may find that you cannot drop the ball anywhere in the Swing Camera. If this
is the case, you will need to use the new buttons that appeared in the Button Bar
when you started the drop mode. To access the buttons, move your cursor to the
lower left corner of the screen until it appears over the buttons. Then click on the
button,

Nearest Rellef - This button allows you to accept the suggested drop ball
location. Use this button if you are having trouble with the ball always
rolling out of play again.

DOrop Backward - Reposition the view so you are directly behind your original
position (remember, you cannor drop closer to the hole). You may find
that in order to have an allowable drop, you need the Drop Backward
button. You may click the Drop Backward button multiple times until you
have a satisfactory area to drop. As you do this, vou’ll notice that the
allowable drop area increases in size.

Brop Farward - A new Drop Forward button appears after you click the Drop
Backward button for the first time. This has the opposite effect of the
Drop Backward button.

Done [Hot Key = ESG] - This option is only available when you arc not being
forced to drop. Select this if you decide not to drop the ball and want to
return to the game.

—birid

Choose when to show the grid for each player on the Player Settings screen. The
grid options allow you to decide when the grid will automatically appear for the
player being edited or created.

The auto show options are:

NEVEr - The grid will never be displayed for the player.

Always - The grid will always be displayed for this player every time the game
redraws a scene.

Chipping and Putfing - The grid will only be dis played when the player is within
chipping distance of the hole. It can be very helpful for finding the break
or the lip of an obscured bunker.

Putting - The grid will only be displayed when the player is on the green. It can
be helpful for finding the break of the green.

Note: The grid can be turned on and off manually regardless of the selected option by clicking
the Grid button on ihe Button Bar or by selecting Grid (X} from the Action Menu.
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—Shot Setup

Shot Setup offers an interface that will allow you ultimate control over the golfer’s
swing. You can adjust the clubface to open or closed, move the ball forward or
backward in the stance, and change the swing plane to outside-in or inside-out. Shot
Setup will then allow you to save your custom shot types. These features, combined
with the TrueSwing™ method, allow the swing to be customized for just about any
shot.

Click on the shot setup icon in the lower left section of the Swing Camera or use the
Action Menu item Shot Setup (Hot Key = Shift + S). The golfer will rotate up for
better visibility and the Button Bar will show the setup shot buttons. When you find
a satisfactory stance, click Done or press ESC to return to the game.

The button bar on the right contains some pre-defined stances and two custom
stances. All pre-defined stances can be changed by pressing Save after editing.
Choose between the following stances:

Straight [Hot Key = Shiff + I] - Reset the shot variables to hit the ball straight.

Draw [Hot Key = Shift + BJ - Scrup a draw shot to get the ball to curve slightly to
the left. This can be used on fairways that curve slightly to the left.

Fade [Hot ey = Shift + F] - Setup a fade shot to get the ball to curve slightly to
the right. This can be used on fairways that curve slightly to the right.

Punch [Hot Key = Shift + PJ - Sctup a punch shot to keep the ball very low and
make it travel as far as possible. This is useful for keeping the ball under
trees.

Flop [Hot Key = Shift + B - Setup a flop shot to keep the ball very low and make
it travel a short distance. This can be used to get back on the fairway from
within the trees.

Gustom [Hot Key = Shift + 10r 2] - Select one of the Custom buttons, and then
customize the shot. Press Save in order to change the Custom shot. Then
next time you wish to setup the same shot, just press the same Custom
button and the last values will be returned.

The button bar on the left allows vou to save, restore, or apply the current settings.
Choose between these options:

§aVe - Save the current settings into the pre-defined stance button. The next
time you select the button, these setrings will be used.

Restore - Restores the pre-defined stance button to its default value. For
example, if you customize the draw shot and want to restore it to the
default, then select Draw, press Restore, and finally select Save.

Done [Hot Key = ESC]- This will end the Shot Setup mode and apply the currently
selected shot to the player’s stance. The selected shot will remain active
until the player continues to the next position. The player will then default
to a straight shot.
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You can create your own shots by moving the golfer, club and ball.
Opening/Closing the Elub FAge - Move the cursor over the clubface until the cursor
changes to a rotation arrow. Click the left mouse button and drag the
clubface open or closed.

® Opened - When the clubface is opened, the ball will be hit to the right
and will gain extra loft. Opening the clubface is typically used to pop
the ball over bunker lips or bushes.

» Closed - When the clubface is closed, the ball will be hit to the left and
will lose some lott. Closing the clubface is typically used to keep the
ball low in order to stay under trees.

Moving the Ball - Move the cursor over the ball until the cursor changes to a
hand. Click the left mouse button and drag the ball forward or backward.

* Forward - When the ball is forward in your stance, you will tend to
strike the ball while in the upward motion of your swing. Moving the
ball forward is a subtle means of gaining extra loft in the ball.

» Backward - When the ball is backward in your stance, vou will tend to
strike the ball while still in the downward motion of your swing.
Moving the ball backward is a subtle means of reducing the loft of the
ball,

Rotating the Swing PIane - Move the cursor over the golfer until the cursor
changes to a rotation arrow. Click the left mouse button down and drag the
golfers swing plane inside-out or outside-in.

o Inside-Out - When the swing plane is inside-out, (pointing right of
forward) the ball will draw or hook. This can be useful for fairways
that curve to the left,

s Qutside-In - When the swing plane is outside-in, (pointing left of
torward) the ball will fade or slice. This can be useful for fairways
that curve to the right.

Note: The shot setup interface is not avadlable while putting.

—Swing [Tri-Glick)

The Tri-Click swing has been the traditional interface for swinging the club in PC
golf games. You will see a Tri-Click indicator directly below the golfer that will be
used to meter the swing power and lateral spin.

"

There are four parts to the Tri-Glick swing:

1. Starting the Swing - Move the cursor over the Tri-Click meter or the golfer
until the cursor changes to a g swing arrow.

2. The Backswing - Click with the left mouse button to start the backswing. The
meter will begin to move right to indicate the backswing. As the meter

continues, the swing power is increased. The mark on the right side of the
indicator represents full power.
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3. The Downswing - Click again with the left mouse button to set the power and
start the downswing. The meter will begin to move left to indicate the
downswing. As the ‘meter continues, the lateral accuracy is increased. The
mark on the left side of the indicator represents a straight shot.

4. The Impact - Finally, click again to set the accuracy and finish the shot.

There are two variables o the Tri-Glick swing:

1. Swing Power - To hit the ball harder, simply allow the indicator to travel closer
to the mark on the right (take a bigger backswing) before initiating the
down swing. However, the more powerful the swing, the more difficult the
accuracy becomes.

2 lateral Movement - When the club head srrikes the ball with any kind of left-
to-right or right-to-left motion, it will impart lateral spin on the ball. The
ball’s flight will be curved because of the lateral spin. This will happen if
you don’t hit the mark on the left side perfectly.

ﬂf‘ﬂw SIMIS - (A shot that curves slightly to the left,) To create a draw, click (the
third click) slightly before the swing indicator reaches the mark on the left side
of the swing merer.

ﬂﬂﬂf{ Sflﬂfs - (A shot that curves extremely to the left.) To create a hook, click
{the third click) well before the swing indicator reaches the mark on the left
side of the swing meter.

fﬂﬂﬂ 3’!!“5 - (A shot that curves slightly to the right.) To create a fade, click (the
third click) slightly after the swing indicator reaches the mark on the left side of
the swing meter.

SII'GE smlrs - (A shot that curves extremely to the right.) To create a slice, click
(the third click) well after the swing indicator reaches the mark on the left side
of the swing meter.

Putting and chipping methods are slightly different.

—_Swing [TrueSwing]

Interactive TrueSwing" is an innovative way for you to get the feeling of truly
swinging the club. You can control the golfer on the screen without having to watch
an indicator. This naturally makes the experience more enjoyable. You can also pro-
duce actual golf swings such as draws and fades {and in extreme cases even hooks
and slices) by changing the path in which you move your mouse. You can also pro-
duce heels, toes, shanks and miss hits if your club is not centered on the ball during
impact.
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There are two types of TrueSwing” to choose from, the vertical swing and the hori-
zontal swing. The following example uses the vertical swing. Pulling the mouse back
is equivalent to pulling the mouse right, and pushing the mouse forward is equiva-
lent to pushing the mouse left when using the horizontal swing.

With Interactive TrueSwing"™, vou can think of your mouse as a “club.” The “face”
of the “club” is the side of the mouse with the cord. The club velocity is the speed

at which you move the mouse. When the “face” of the “club” strikes the ball with
any kind of left-to-right or right-to-left motion, you impart spin on the ball.

Note: A golfer in TrueSwing" mode will not have the indicator that is seen in Tri-
Click mode.

There are three parts to every TrueSwing :

1. Starting the SWing - To starc swinging, move the cursor over or near the golfer’s
club. The cursor will change to a g # swing
arrow. Click the lefr mouse button to start the swing.

2. The Backswing - Pull the mouse back until the golfer has completed the desired
amount of backswing. Bigger backswings usually result in longer shots,
Use the ESC key to cancel the swing.

d. The Bawnswing - Push the mouse forward to complete the swing. The down
swing is the most important part of the swing because it controls the
power with which the golfer will hit the ball, as well as whether the club is
moving right-to-left or left-to-right when the club head meets the ball.

There are three variables to every TrueSwing:

1. Swing POWEr - To hit the ball harder, simply push the mouse forward more
quickly. The mouse speed parallels the club head speed.

2. lateral Movement - \When the club head strikes the ball with any kind of left-
to-right or right-to-left motion, it will impart lateral spin on the ball. The
ball’s flight will be curved because of the lateral spin. If the club is not
centered on the ball during impact, then the balls flight can be angled or
miss hits can occur,

d. JEMPE - An even tempo helps achieve the perfect swing. Ideally, the
Downswing should be about two-thirds the duration of the Backswing.
Good tempo will result in better shots and lessen penalizing errors. Slow
Backswings with rushed Downswings or rushed Backswings with slow
Downswings will hurt the distance and accuracy of the shot. Long delays
at the top of the Backswing will also result in shot errors.

rﬂE/HEE’ smlfs = This situation occurs when the club is not centered on the ball

during impact. The club starts out centered on the ball. As you begin to swing,
your back swing may move left or right of the center. If you fail to bring the
club back to its starting position, you will hit the ball with the toe or the heel
of the club. Hitting the ball with the toe or heel will decrease the distance the
ball will travel and change the departing angle of the ball left or right. If you
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slide severely right or left, you may miss the ball completely. Some terrain types
are more prone to miss hits. Toes and heels are more common in rough or sand
if the club is not centered on the ball.

ﬂf‘ﬂW/"ﬂﬂk smﬂs = (shots that curve slightly/extremely to the left.) To create a

draw or hook shot, pull the mouse back and to the left. Then move the mouse
forward and to the right to start your downswing. Be careful to finish the
swing in the same position as started to avoid toes and heels. You can ‘control
the amount of draw or hook by adjusting the amount of left input during the
backswing.

faﬂE/SImﬂ SMIS = (a shot that curves slightly/extremely to the right.) To create

a fade or slice shot, pull the mouse back and to the right. Then move the mouse
forward and to the left to start your downswing. Be careful to finish the swing
in the same position as started to avoid toes and heels. You can control the
amount of face or slice by adjusting the amount of right input during the back
swing.

Experiment with different degrees of left-to-right, right-to-left, right-to-right, and
left-to-left mouse movement during the swing to see the various results.

Putting and chipping methods are slightly different.

Note: If you are consistently slicing or hooking the ball, you may have the mouse rotated in
your hand even though it may appear to be aligned straight. Many mice have funny shapes
and it is difficult to tell when it is straight. To determine a straight alignment, you can nove
your cursor along a straight vertical line. As long as the cursor stays on a vertical !!.I?(f_. Ib.e
mouse is oriented correctly. If vou are consistently toeing or heeling the ball when intentionally
hooking or slicing, try angling the mouse and swinging straight.

— Putting and Ghipping

Putting and chipping methods are different from swings taken from the tee. Both
use a different method for swing power and putting reacts differently to lateral
movement. The result is that you will have to use more touch on your stroke.
Swing Pawer - The distance the ball travels depends largely on the backswing.
The further the club is pulled back, the greater the momentum of the club
head and the further the ball will travel. To hit a short putt or chip, pull
the club back slightly and swing. _
Lateral Movement - The puticr does not impart lateral spin on the ball. The effect
is that the ball will travel in the direction it is hit. You will have to be
careful about lining up your putt according to the break of the green. To
do this, use the grid. Not getting the club center back to the ball will
produce the same results.
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—S8cores

Sc_orr‘:s can be viewed by selecting Scores (Hot Key = Shift + S) from the View
Menu. The screen defaults to a Score Card. It will contain the scores for each player

in the player’s group. It can be switched to a Leaderboard that will display the
scores for every player in the tournament, i

l;lhc score screen will show the current course conditions and the course difficulty in
the upper left corner. The conditions were selected from the Gasme Settings screen
and the course difficulty is used in calculating handicaps.

I'he score screen contains many burttons that will sort the list. Sort the list using the
Name, Team, Score, Handicap, strokes on a hole, and total strokes. Just click on the
buFton and the list will update. The handicap column displays the team’s handica
being used to calculate the score. It will only he displayed if you select Use g
Handjicaps from the Game Settings screen.

Click the Back 9 or Front 9 button to see the back nine and front nine scores.

Click tbe Leaderboard or Score Card button to view every player’s score or just the
scores in your group.

If you are play‘ing 72 holes, there will be four buttons thar specify which round is
being played. Select the round you want to view and the list will update.

Note: You can print the current scores by pressing the print button & in the top right cor-

Hey t),ir I:}J(.,’ scores screen 1”'7!5 IL"I‘H P?{.!’If ﬂH ores ¥ P rin EF L HITEN-
) C . FCore fr() eacb l’{? 'E. Ihe o-rd £, e 1
> v er i ey are curre
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—Statistics

There are four sets of statistics that are automatically tracked: Player, Course, Top

Medals, and Handicaps. These statistics are useful in comparing players and cours-
cs. The statistics can be viewed by selecting Stats from the Main Menu or by select-
ing Stats (Shift + T) from the View Menu.

When playing Internet games some rooms will calculate statistics that will be
displayed online.

In order for statistics to be calculated, you must be playing regulation rules.
Regulation can be selected from the Game Settings screen under Options. You will
not be able to take mulligans or gimmies using regulation rules since both would
alter the statistics.

The player statistics include the following:

Holes Played
Rounds Finished
Holes In One
Chip Ins

Driving Distance
Driving Accuracy
Average Putts
Sand Saves
Scrambling
Greens in Reg.
Handicap
Average Score
Total Eagles
Birdies Per Round
Pars Per Round
Bogeys Per Round
Other

Average Par 3
Average Par 4
Average Par §

Number of holes plaved.

Number of rounds finished.

Number of holes-in-one achieved.

Number of chip-ins achieved.

Average distance achieved per drive.

Percent of the drives that landed on the fairway.
Average number of putts to get to the cup.

Percent of par recovery from landing in sand.
Percent of par recovery without green in regulation.
Percent of greens hit in regulation {green hit in par -2)
The player’s handicap.

Average score per round.

Number of eagles achieved.

Percent of birdies per round.

Percent of pars per round.

Percent of bogeys per round.

Percent of remainder.

Average strokes on par threes,

Average strokes on par fours.

Average strokes on par fives.

*Deleting and recreating a player will remove bis or ber statistics.

The course statistics include a column for the front 9, back 9, and for the entire 18
holes. The staristics include the following:

Total Yards
Total Par

Holes In One
Driving Accuracy
Average Putts

Total number of yards for the course.

Par for the entire course.

Number of holes in one achicved on the course.
Percent drives that landed on the fairway.
Average number of putts to get to the cup.
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Greens in Reg. Percent of greens hit in regulation

(hitting the green in par -2)

Average score per round.

Number of cagles on the course,

Percent of birdies per round on the course,
Pars Per Round Percent of pars per round on the course.
Bogeys Per Round Percent of bogeys per round on the course,
Other Percent of remainder.

Average Score
Total Eagles
Birdies Per Round

*Use the Course Manager to delete the stats for a specific course.

The top medals screen shows a list of the top scores achieved on the current course
using Medal play. New players are added to the list at the end of a Medal round.
Computer players are not added o the list.

Note: You can print the current statistics by pressing the print button 8 in the top vight cor-

ner of the statistics screen.

— Using the Gourse Architect

The Course Architect allows YOU to create custom courses that can be played using

PGA Championship 2000. Courses built with the architect can be shared with oth-
ers and played in remote games.

The tools to create a new course are as follows:

Menu and Button Bptions - Usc these options to make selections and customize the
course.

EGreate a New Gourse - Quickly lay out any number of holes (up to 18) and
outline the terrain shapes, then apply terrain to shapes that make up each
hole {rough, fairway, water, etc.)

Use the View Inlerface - Use the visual interface to navigate and create custom
courses.

Improve PErfOrmance - Remove redundant and unnecessary data from the course
and reduce the course perimeter.

L'IWPSE ﬂl‘ﬂﬂﬂﬂ.‘.‘f [Phﬂﬂﬁﬂﬂﬂﬂ * Great artists can create spectacular works

regardless of the tools given them to work with, but with the right tools, any
one can create something they can feel proud of. A course is much more than
the sum of its holes. The way holes interact with each other and the terrain
plays an important role, Qur response was to create the Course Architect with
the tools necessary to allow anyone to create a prize-winning course with
minimal effort and to allow the creation of an entire course (not just individual
holes.) Whether you are one of the great architects or just a computer game
fanatic trying to get the most out of a game, we believe you will find the
Course Architect fun and easy to use.
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Menu Bptions [Architect]

The pull down menus at the top of the application window provide options for
course creation. These options are available when there are no modal windows

being used. The menus are:

€ PGA Championship Golf
Game  Action  Miew ﬂir.dc.\_-\-_mﬁ’_‘:ip

File - Contains options like creating, saving, and exiting a course.
Edit - Edit the selected object or undo your last action. _
View - Contains options to show or hide the button bars and move or zoom into
the Work Window. ‘ ‘ .
T80IS - Contains options to create or edit shapes and objects in the Work
Window. _ ‘
Windaw - 1cts you select alternate ways to view the course and its elements.
Help - Opens the on-line help manual and provides About information.
» Contents (Hot Key = F1) - Opens the on-line help manual beginning
with the Contents page. N
e On Item (Hot Key = Shift + F1) - Displays the context-sensitive help
cursor. Click anywhere on the architect interface to get help on that
item. . _
* Keyword (Hot Key = Ctrl + K) - Opens the on-line help manual in
keyword search mode. '
* About - Displays an information box about the Course Architect and the

current systems resources.

—File Menu

Choose File from the Menu Options to access the following commands:

New [Hot Key = Birl + N] - Creates a new empty

it Wi Tools  Window :
gt course, 2000 yds. long by 2000 yds. wide.

E:i Couise Wizard. Fild e New Course Wizard - Starts a new

Clpen 2 Chl+D) course wizard that leads you through
Save Chl+s the creation of a course. _
Save fs.. | Open [Hot Key = Gtrl + 0] - Opens an existing

course that was previously saved.
""" | Save [Hot Key = Girl + 8] - Saves the currenc
course. Ask for a file name if the course is
! g unnamed.
Commf&rmswa i Bave fIs - Asks for a file name and location,
1 Rivenvind.ach then saves the current course.

Import Course Library

Course Properties...

Exit
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— Edit Menu

Choose Edit from the Menu Options to access the following commands:

Import Gourse Library - Allows a library to be imported so that it can be used in
the Course Architect. When selected, a dialog box will appear allowing
you to select the (.clb) library file, When the Open button is selected, the
library will be added as a tab in the librarian.

Gourse Properties - Provides information about the course and allows the course
to be named and resized.

Gourse Infg - Shows the courses memory usage, number of objects, number of
points, and other course related information.

Gompite Bourse - Compiling your course creates a course that PGA
Championship Golf™ 2000 can load and play. You must compile your
course before you can play it. There arc only a few options to compiling a
course. It is possible to create your course with or without trees, bushes,
and 3D structures. It is also possible to create your course without
shadows. These options can easily be turned on or off simply by clicking
the check box next to the option. The last options allow you to register
your course with PGA Championship Golf™ 2000 so that it will be avail
able for playing and testing. Each course played within the golf game uses
textures, objects, structures, sounds, and panoramas that are stored in a
course library. In order for a course to be played, the appropriate library
or libraries must be loaded on your computer.

Mast Recently Used Files - This section contains a list of the most recent files that
have been open in the Architect. The list can contain up to four files and is
useful in allowing quick access to previous course files. This list will be
empty the first time that the Architect is launched after installing.

Exit [Hot Key = Alt + FA] - Requests to save the current course, then closes the
Architect,

Wiew Took Window Help

LUnda ChilvZ
Delete Del
Dugheate Chl+D

Select All 3

Diop Selected Shapes |nsert

Undo [Hot Key = EBtrl + ] - Undo the last action {Insertion, Deletion or Terrain
Manipulation)

Belete {Hot Key = Bel] - Delece all items that are currently selected in the Work
Windouw.

Duplicate [Hot Key = Birl + Of - Make a copy of all items that are currently
selected in the Work Window.

Seleet All - Selects all land shapes, paths, hazards, sounds, 2D, and/or 3D
objects.

PGA Championship Golf ™ 2000 66

Brap Selected Shapes [Hot Key = Insert] - Drop all floating shapes that are
currently selected in the Work Window. The shapes can still be dropped
one at a time, by clicking the right mouse button on an existing shape and
choosing Drop from the menu that appears, or by double-clicking in the
shape itself.

— View Menu [Architect]

The Menu Options contains options to show or hide the button bars and other win-
dows. You can use Zoom and Scroll to adjust the Work Window. The arrows corre-
spond to the direction the camera will move in the course. They do not change the
camera height.

Todls Window Help File/Edit togls - Show and hide the file and
v Eile/Edit Tools 2_ edit tools.
v Colrse Taok 1 Gpurse fools - Show and hide the course
v Window Tools tools.
;. Mavigalian Toels Windew fogls - Show and hide the window
W Statusﬂa;_ tools.
v Course Perimeter  Shifl+C Navigation togls - Show and hide the
v Hazads Shift+H navigation tools.
Yiim e i Status Bar - Show and hide the status bar.
: i’;ﬁnd g o i Course Perimeter {Hot Key = Shift + GJ - Show
i e and hide the course perimeter.
L) el Hazards [Hat Key = Shift + H] - Show and hide
....ﬁ.ﬁndemg Flabe :..S.h!hJ'M. B all hazard shapes.
Zoom _ ’ Shot Paths [Hot Key = Shift + BJ - Show and
sadl vl hide all shor paths.
Cenver Camera Chrl+C Sound Pesitions ﬂl'.ﬂf Hey = Shift + §] - Show
Center Rotate Origin Chil+Shift=C and hide all positioned sounds.
Use Metiic Grid [Hot ey = B] - Show or hide the grid in

the Work Window.

Library [Hot Key = Shift + 1] - Show and hide the Library window.

Modelting Ciay [Hot Key = Shiff + M] - Renders the entire course in solid modeling
clay color,

ZBOM - This option will bring up another menu that will allow you to zoom in
and out of the Work Window.

In [Hat Hey = I} - Move in closer to the course.

Dut [Hot Key = Shift + I] - Move away from the course.

Select [Hot Key = Alt + Z] - Move in until the current selection fills the screen.
After selecting the button, move the cursor over the Work Window to the
top left corner of the area. Hold down the left mouse button and drag the
cursor to the lower right corner of the area, then release the mouse button.
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Gancel [Hot Key = Alt + Shift + Z] - Return to the default camera height. When
zoomed in close to the ground, many times it is easier to cancel the zoom,
and then use the Zoom To Selection tool.

Sergll - This option will bring up another menu that will allow you to move the

Work Window around the course.

o Left (Hot Key = Left Arrow) - Moves the camera to the left.

e Right (Hot Key = Right Arrow) - Moves the camera to the right.

* Up (Hot Key = Up Arrow) - Moves the camera toward the top of the
screen.

e Down (Hot Key = Down Arrow) - Moves the camera toward the bottom
of the screen.

Genter Gamera [Hot Key = Girl + CJ - Moves the Camera Window into to center
of the current Work Window.

Center Rotate Origin [Hot Key = Girl + Shift + B] - Moves the rotation origin used
for rotating land shapes into to center of the current Work Window.

lIsg MEBIriE - The architect will use the metric system in displaying distances.

—Librarian

—Tools Menu

The Tools Menu contains options to create or edit shapes and objects in the Work
Window. You can measure or rotate existing objects and make elevation changes to

the course.

Course libraries are collections of things that can be placed on the course. Trees,
bushes, rocks, ball washers, bridges, stairs, and sounds are all stored in course
libraries. The architect can only use objects that are found in course libraries. If cus-
tom objects are to be used in a course they must first be compiled into a course
library. The architect comes with several pre-built course libraries.

Open Library - Select Library from the View Menu or Button Bar, The librarian
will appear, containing one page of items for each library registered on the
machine.

Glose Library - Select Library again or use the standard windows close icon in
the upper right corner of the library window.

Add Bbject - Move the cursor over an object in the Library View and hold down
the left mouse button. Drag the object over the Work Window and place it
by releasing the button. This will drop the object onto the course. To place
many objects of the same type, use the Click-Click or Foresting Tool
methods.
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Wwindow Help FI"BHTE Iaﬂﬂ Sﬁﬂpﬂ IHM ng" = U - Used to

Create Land Shape L create land shapes for the course. Land
Create Path P shapes begin in the Work Window as
CreateHazardAien objects that float above the course. While
i skl I they are floating, the points can be
Fintats ClkA selected, pulled around, inflared, and
Measiie Clrlshd rotated. Dropping a land shape malkes it
e it O TetaLE O e higse
ke & Bkar BltaShied becomes part of the terrain it cannot be
Make s Slope AlteShiftL resized or repositioned until it is picked
Smpcth anbiea AltShift+5 up ﬂgail’L
| Balenendes  AbeShitf | Greate Path [Hot Key = PJ - Used to begin
Foresting Tool Shift+F creating a path. Click the left mouse
Click-Click Object Tool  Shift+0 button on the Work Window. Each
. Hots Definition Toal - D mouse click will add a new point to the
i DErlindesos . AGCHAD | path shape line. The last point is added
B Setngs. Shift+ | by double clicking the left mouse
Fzpair Coursz.. i button. The sides of the path are always

parallel to the central line segment.

Creale Hazard Area [Hot Key = H] - Parts of the course may be marked as hazard
arcas. When the course is played and the ball lands in these areas the
hazards rules will apply. Hazard shapes are not dropped onto the course.
They always float above the course and are drawn in red. Create the
hazard areas by clicking once for cach point, and double clicking to finish
the shape.

Create Course Perimeter [Hot Key = L] - Mark the outside boundaries of the

course.

Rotate [Huf Hey = Birl + B} - Rorate selected objects and points around a central
marker. After selecting Rotate, a square with a cross in it will appear on
the screen. This marks the spot around which all selected points and
objects will be rotated. Move this mark by clicking it with the left mouse
button, and dragging it to a new position. Rotate the points by clicking the
selection with the left mouse burton and dragging it around the screen. To
finish rotating the points, select Rotate again. Interesting changes can be
made to a shape by selecting only some of the points before beginning the
rotate.

Measure [Hot Key = Birl + MJ - The measuring tool will show the horizontal and
vertical changes between two points on the course. To start measuring hold
down the left mouse button on the Work Window and drag the cursor
around the course. If the game is set to use the metric system, then the
Measure tool’s units will be in metric as well. To change this setting, use
the General Options in the game.
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The Land Tools

Make a hill {Rot Key = Alt + Shifl + H] - Press this button to bring up the hill tool.

This tool can be used to move the land up or down with smooth edges.

The transitions between modified land and unchanged land is smooth.
Make a bunker Iﬂﬂf Hey = Alt + Shift + B] - Press this button to bring up the

bunker tool. This tool is used to move land up or down with sharp edges.

The transitions around the Land Shape’s edge will be sharp.

Make a siope [Hot Ney = Alt + SHiff + I] - Press this button to bring up the slope
tool. This tool is used to move land up or down with a sloping edge. The
Slope Tool will make a hill or depression with a sharp edge. The
transitions around the Land Shape’s edge will be sharp. If the ground is
originally flat, this tool will make an elevation change where the sides of
the change are flat. This tool is especially useful when trying to tilt all or
part of the entire course.

Smooth an area [ﬂﬂf Hey = Aif + Shift + 8] - Press this button to use the
smoothing tool. Smoothing can get rid of irregularities that creep in from
frequent elevation changes made to the land by the other tools. This tool
will allow you to specify anvthing from lightly to aggressive smoothing.
When the tool is instructed to lightly smooth, it considers a small radius
around it in determining the new elevations. For an aggressive smooth, the
tool will consider large arcas of terrain to find the general trend in the ter
rain. Everything within the selected Land Shape will be smoothed.
Smoothing is nor a real-time operation, after the operation is specified,
then the changes are applied.

Flatten an area mﬂf Key = Alt + Shift + ﬂ = Press this button to use the flatten

tool. Flatten will make the selected area flat and optionally level. A dialog will
offer these four options for flattening:

» Along Contour - This will flatten the area to match the contour of the
selection. This is useful if vou have a bunker in a side hill and want to
remove it. The area will be flattened to match the side hill. This tool
can produce strange results when used on uneven terrain. It 1s best
used on simple elevation changes.

Maximum Height - This will flatten everything in the selection to the

maximum height inside it.

Average Height - An average height of all the terrain inside the selection

is calculated and the terrain is set to this height.

Minimum Height - This will flatten everything in the selection to the

minimum height inside it.

Care should be taken when using this tool, for it will destroy any
elevation information inside the selection and replace it with the
flattened terrain. A single floating land shape must be selected to use
this tool. Everything within this selection will be flattened. This tool
will result in very sharp edges and is used well in conjunction with the
smoothing tool. Flattening is not a real-time operation, after the
operation is specified, then the changes are applied.

*

Faresting Tool {Hot Key = Shift + F] - Use this tool to forest an area or place
flowers in a flowerbed. Before selecting this tool, create and/or select a
land shape where the objects should be place. Then click on this tool to
bring up the Foresting Tool dialog. This dialog allows you to choose the
object, height, and the number of objects to place inside the land shape.
Click the Apply button to forest the shape with the selected object. This
tool can be used many rimes on the same land shape.

Eligk-Click Object Too! [Het Key = Shift + B] - This tool adds an object such as a
tree or building to the course. Once an object has been selected from the
library view, it will be placed on the course each time the left mouse
button is clicked over the Work Window.

Hole Definition Tool [Hat Key = 0] - Define all of the positional information for the

course (tee positions, pin positions, etc.)

e Point Count Indicator (Hot Key = Alt + Ctrl + D) - Each dropped shape
has a number of points that are used to define the terrain within that
shape. This tool allows you to select all dropped land shapes that have
more than a certain number of points. For example, if 10,000 is
selected, this tool will highlight all the shapes that have 10,000 or
more points. This is useful in targeting shapes that can be used with
the Optimize Detail tool.

Grid Settings (Hot Key = Shift + G) - Brings up the Grid Settings screen

which allows you to select the distance between the grid intersections.

When the grid is enabled, it will be displayed in the Work Window.

Lach dot in the grid represents an intersection of the grid sections.

Select Grid from the View Menu or use the Grid button from the

Button Bar to turn the grid on or off.

Note: Do not confuse this grid with the grid that shows up when doing elevation changes.

Repair Gourse - Goes through the entire course and repairs any invalid data.
Occasionally when dropping land shapes or performing terrain elevarion
changes, redundant or invalid data is introduced. These situations arise
very rarely but are difficult to detect without running this tool. If a repair
was needed, you will be informed. Running the tool when no corrections
are needed has no effect.

—land Tools

The Tools Menu contains the Land Tools options that deal with elevation changes
in the Course Architect. They give you the feel of molding and shaping the ground
into hills and valleys, much like a potter works with clay. These tools provide ways
of easily modifying the elevation of the terrain in a smooth and efficient manner.
You can choose operations that make a hill or valley, a bunker or mound, a flat-
sided hill or valley {called slope), and smooth or flatten terrain. The Land tools are
not available until conditions exist where the elevation change is applicable.

Note: Multiple land operations will begin 1o add redundant points to the course. Removing
detail will increase performance without reducing the visual guality,
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To specify what areas are to be affected, you must select Land Shapes. All of the
elevation tools require at least one selected Land Shape. It is inside this land shape
that the elevation tool modifies the terrain. In the case of Hills, Bunkers, and Slopes,
vou can select two Land Shapes. When using two Land Shapes, it is required that
one of the Land Shapes be completely within the other Land Shape. In this case, the
outside Land Shape indicates what terrain should be modified. The inside Land
Shape changes the shape of the Hill, Bunker, or Slope that is created. These tools
can be used to make both very large and sweeping changes, or very small and subtle
changes.

Hill, Bunker & Slope tools - After selecting one of these tools, a dialog is displayed, -
asking for the desired elevation change. You can indicate whether the elevation
change is up or down. An edit box is provided for exact elevation changes. Use
the slider bar to change the elevation in a more intuitive and reactive way.
Clicking either OK to apply or Cancel to ignore the change dismisses the dialog

box. _
% g 7 Dovn Helgit %D.S Feet

57|
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These tools are able to operate with one or two selected Land Shapes. If two shapes
are selected, one of the Land Shapes must be completely inside the other shape. It
only one Land Shape is selected, then the center of the shape will be raised or low-
ered. If two shapes are selected, then the inside shape will be moved the full amount
requested The terrain that lies between the inside and outside Land Shapes will be
moved at varying degrees to create the specified affect.

You must keep in mind that these tools make changes to the existing terrain. If thfe
terrain is originally flat, it will make a recognizable Hill, Bunker or Slope. If fllultl"
ple elevation operations are conducted upon the same land area, the result .wdl be
the aggregate, or combination, of all the changes made. Use the Camera Wmduw to
see real-time visual feedback. A grid will be displayed, indicating what the terrain
will look like after each elevation change is made.

Note: Multiple land operations will begin to add redundant points io the course. Removing
Detail will increase performance without reducing the visual quality.
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— DOptimize Detail

Optimizing detail is a performance-increasing feature that no designer should
ignore. When doing elevation operations, (Hill, Bunker, Slope, Smooth, and Flatten})
detail is added to the course to make the elevations look good. The architect will
add detail only to the arca affected by the clevation change. As more detail is added
from multiple elevation operations, redundant points begin to appear in the course.
This redundancy should be removed.

Redundant derail is eliminated using the Optimize Detail tool. Moving the cursor
over a Land Shape that outlines the area in question. The Point Count panel on the
right end of the Status Bar will show the number of points contained in that shape.
Click the right mouse button and choose Optimize Detail from the menu that
appears. When the dialog appears, select the level of removal that is desired. If
detail needs to be removed from the objects enclosed within the shape, select the
include children option.

Optimize Detail | It is very important to run this tool periodically
Le»felﬂan ' ] during the creation of courses. Optimizing
 hde TEE detail will improve the performance of the

b g architect by reducing the size of the course file
A and memory used. A/l terrain objects should
il 4 have detail optimized at the smallest detail
I Inchade Chisken: optimization setting (even greens and bunkers).
= s : This eliminates significant detail without affect-
This can stenstimes be & lengihy . :
operation Plan acccidingly ing the visual appearance of the course. Many
¥ apping the Escape key wil canocst terrain objects should have detail removed at
b the openalin, much higher levels. Examples of these objects
[Tk ] . Cocel | are the main weed-rough texture that encircles
s the whole course, as well as objects that house

flowerbeds or forests.

Note: Use the Point Count Indicator in the Tools Menu to quickly find shapes that have a
high number of detail points. These shapes often have redundant or unnecessary points that
can be removed.

—Window Menu [Architect]

The course architect allows three different ways to view the course. The Work
Window is always visible and is used to place and manipulate shapes and objects. It
can be maximized to fill the entire application window. All other views can be
shown and hidden from this menu in the Menu Optlions.
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Wark Window - Where all the work is done. It cannot be hidden and may be

maximized to fill the entire application window.

e Float - If the Work Window is currently maximized, this will cause the
window to float in the application frame like the other windows.

s Maximize - This will cause the Work Window to fill the entire
application window.

Gamera Window - Brings up a perspective view of the course and places a ¥
camera icon in the Work Window. You can position and rotate the camera
using this icon. This window will give you an idea of how the course will
look in the game.

Navigation Window - Used to quickly move the contents of the Work Window to

see different parts of the course. Most of the course can be seen in the Work

Window’s default position, but when the camera is close to the ground; only a

small part of the course can be seen. The navigation view has a white rectangle

that shows how much of the course is in view on the Work Window. The rec
tangle can be moved around by clicking the left mouse button inside the
rectangle, then dragging it to a new location. The Navigation Window can also
be opened from the Button Bar.
e Cascade - Arranges the open windows in a cascading fashion, starting at
the upper left.
e Tile - Arranges the open windows in a tiled fashion.

—Button Bar [Architect)

The Butron Bar is available on the application just below the Menu Options. The
button bar buttons are quick references to the Menu Options. The most commonly
used features of the course architect are quickly accessible from the application
Button Bar. For a quick description of any of the buttons available, move the cursor
over the burton in question for a second or two and a message will appear that

describes the button’s function. Use the View Menu to show or hide the button bars.
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Fife and Edit Buttans - The File Buttons are used to create, open, and save the
course and are also available in the File Menu. The Edit Buttons are used
to delete, duplicate, and undo selections and are also available in the Edit
Ment.

| olxlef slo]

Tools Buttons - The Tool Buttons contain options to create or edit shapes and
objects in the Work Window. You can measure or rotate existing objects
and make elevation changes to the course. These options are also available
in the Tools Menu. Land Tools are powerful operations that allow you to
create hills, bunkers, and slopes. The Click-Click, Forest, and Hole
Definition tools allow objects to be placed on the course and tees, pins,
and shot paths to be selected for a hole.

Window BUtons - Lets you select an alternate way to view the course and its
elements. These options are available in the Window Menu and the
Librarian can be accessed from the View Menu.

oy

el»le]e] afala]

Work Window Bulons - These options allow you to move the Work Window

around the course and zoom in and out of selection. These buttons are
available in the View Menu.

Note: Each of the four groups of buttons can be dragged off the main button bar. Each group
then becomes its own button bar. These button bars can be rearranged, docked to either side
or the bottom of the application window, or can be left floating in a button bar window by
themselves.

— Status Bar

The Status Bar is displayed along the bottom of the main application window. It can
be displayed or removed by selecting Status Bar from the View Menu. There are
several pieces of useful information displayed in the Status Bar. From left to right,
they include:

Button/Menu Item Bescriplions - When you move the cursor over a button or menu

item, this panel shows a description of the tool and what it does.
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Current Mode - The current mode of the architect is displayed in this panel. The
current mode can be Freechand, Measure, Rotate, Select, etc, depending on
the tool currently being used.

Position & Flevation Feedbagk - Any position on the course can be described by an
(x, y) position. As you move the mouse cursor over the course in the Work
Window, this panel will display the current position and elevation on the
course. The units will either be in feet/inches or in meters/centimeters,
depending on the setting selected from the General Options in the game.

Point Count - As you move the mouse cursor over a dropped land shape in the
Work Windouw, this pancl shows the number of points that the object
contains. Use Optimize Detail to reduce this number where applicable.

— New Gourse

To create a new blank course, select New from the File Menu. The process of creat-
ing a course from scratch can be fairly tedious so in order to save time, select New
Course Wizard from the File Menu. This will lead you, step by step, through the
creation of your course. The wizard is used to start your course; the menu item will
be grayed out once the course creation has begun.

The purpose of the wizard is io allow you to quickly:
e Lay out any number of holes {up to 18)
o Apply textures to the terrain shapes that make up each hole {rough,
fairway, etc.)
o Create any water objects on the course.

Cancel :i

The wizard uses Next, Back and Cancel buttons to navigate through the dialogs.
The very last page has a Finish button, instead of Next. Finishing the Wizard moves
the work done in the wizard to the Work Window where it can be manipulated in
the same manner as any other object. Each wizard screen has a top view of the
course on the left side, and customization controls on the right. The screens are as

follows:

Wllﬂl‘ﬂ Sﬂl'ﬂﬂﬂ.' Wﬁlﬂﬂmﬂ - Explains the usage of the wizard. The wizard will
automatically be displayed when the Architect is launched for the first time.
Use the checkbox on this screen to force the wizard to be displayed each time
the Architect is run.

This wizard auiomates the most coman
tasks of laping out the Bacic alemerits of 2
owe goff counze, [t fezbunes:
* Hile fagoult ocks 1o define hole Jerth, -

posilion, and par. i
|~ Waber cieation tool to create lakes,

| pords, efe. ! f

* Diflscert telizes Lo choose from such

a8 waler, iough, Ly, finge, ¢,

Click the "Mest bultori io proceed.
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wrlﬂrd SL'PEEH.' Mﬂfﬂ rﬂﬂlﬂ'ﬂ = Select the main texture to use throughout the

course. The selected texture will be visible outside of any terrain objects. The
drop down combo box is used to choose the texture. When a texture is
selected, the wizard’s editing window will reflect the change. Textures listed in
green are playable, meaning thar if the ball lands on it in the game, no drop is
required. Textures listed in red are unplayable, meaning that the game will
r\equire the player to drop on the nearest plavable texture, with a penalty.
Those listed in blue are unplayable but allow free drops, meaning that the game
will require the player to drop, but without a penalty (used typically for areas
such as cart-paths). ' f

."’-’Wj RouahPsa s (aals Wilal' d sm' Ben: Wﬂﬂ.’f’ = Create water objects for

the course. Move the cursor over the wizard’s
editing window, click and hold down the left mouse
i Dismand Ber button, draw out the water object, then release the
it _ left mouse button. A line will be drawn by the

_J cursor that follows its movements, When the mouse
Dit [Prinseville) burton is released, connecting the last point with the
first point closes the line. The area is then filled
with blue. To deléte a water object, select it by
clicking on it, and then press the Delete button.

»

Be careful when drawing the water object, these
cases will not be allowed:
e Lines cannot cross over themselves.
e Lines cannot cross over other water or holes.
e Lines cannot entirely encompass other water or holes.
® Lines cannot be too small (only a few pixels big).

Wizard Sereen: Holes -

The Hole page is used to create
the holes that make up the course. It is
not necessary to create the holes in suc-
cession or to create all 18 holes. The
up and down arrows next to the hole
number can be used to select the hole
to create. Once the hole is created, the
Created check box will be selected and
the information in the Hole and Course
sections will be updated.

1 e fight 2t s g e e,
e e lasiadon e
B i B
st Bt bty
Tokalbepdage: 4GS

1 kg

1 ek U

1 Py that s 10

Belps Thafee 1
ol Ahoike 12
Holpx Shoker 3

1 Aeesteamapm: T

PGA Championship Golf ™ 2000 I




You will only be allowed to create par three, four, and five holes. Follow these
directions to create the following:

Create a Par Three - Move the cursor to the desired tee-box position and click
the left mouse button. Then move the cursor to the desired green position
and click the right mouse button.

Ereate a Par Four - Move the cursor to the desired tee-box position and click the
left mouse button. Move the cursor to the position where the tee-shot
should land and click the left mouse button again. Then move the cursor
to the desired green position and click the right mouse button,

Greate a Par Five - Move the cursor to the desired tee-box position and click the
left mouse butron. Left click on the position where the tee-shot should
land, then click again where the second shot should land. F mnally, move the

Wflﬂl’d SEI'EEH.' SMM TEHIH'ES - Specify the texture of each part of a hole

or water. Select them from the drop down list provided on the screen. They are
color-coded indicating the playability of each texture: green (playable), red
{unplayable}, and blue {unplayable, but with a free drop}.

W‘ZEP d SEP een. f lﬂiSh * When the Finish button is pressed from the final

screen, the wizard takes all the water objects, holes, and textures, and draws
them in the Work Window. Use the Navigation or Camera windows to
examine the new holes.

cursor to the desired green position and click the right mouse button.

The wizard does a lot of checking, during and after the creation of a hole, to make

sure that the holes can be drawn at the specified position. Holes are not allowed to
do the following:

¢ Holes cannot cross over themselves.
* Holes cannot cross over other water or holes.
® Holes cannot entirely encompass other water or holes,

—Land Shapes

Land Shape mode can be selected from the Button Bar or the Tools Merit. _{Ja_rzd
Shapes begin in the Work Window as objects that float abo‘..'e the course. While
they are floating, the points can be selected, pulled argund, inflated, and rotated.
Right click on the floating shape to get a menu of options to perform on the shape.
Dropping a shape makes it part of the terrain. Once tl}e shape becclhmes part of the
terrain it cannot be resized or repositioned until it is picked up again.

Use the following options to manipulate Land Shapes:

® Holes cannot be any closer than half a hole’s width to any other object or to
the edge of the course.

As a hole is created, a line will be drawn from the last point defined for a hole to
the current position of the cursor, If the line is shown as black, it is okay to place a
part of the hole where the cursor is. The line will turn red if it is not okay to place a
part of the hole at thar position.

Allowed Nort allowed

The information contained in the Hole section, such as the Shot Yardage, is updared
as the hole is created. The information in the Course section is updated after each
hole is created. To delete a hole, select it by clicking on it, then press the Delete but-
ton. During the creation of a hole, the Delete button changes to a Cancel button.
Use this to cancel the creation of the hole at any time.

Note: When using the wizard, sometimes you may create a hole whose objects cross over
themselves. If any of ihe shapes that make up the bole {fairway, fringe, green, etc.) cross over
any of the hole’s other shapes, the hole is not allowed. Since the resolution of the wizard’s edit-
ing window is so small (one pixel represents just over a five-by-five yard), it’s sometimes hard
to tell that a hole’s shapes are crossing each other. When using the wizard, we recommend that
you stick to creating holes that don’t have too many drastic angles in them, and then adjust
the holes using the land tools in the Tools Menu.
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Greate [and Shapes - Click the left mouse button on the Work W’Endouf and a
new point will be added. Continue clicking until the new shape‘is
complete. Double-click the left mouse button to add the last point and
finish the shape.

Deiete Land Shapes - Select the shape by moving the cursor over it and click the
right mouse button. Choose Delete from the menu that appears. The shape
may also be deleted by selecting all the points and pressing the Delete key
on the keyboard. Choose Delete with Children to delete both a dropped
land shape and any other shapes that are positioned inside of the shape.

Modifying Land SHapes - The points on a land shape may be moved, deleted, and

duplicated. When the cursor is moved over a point, it will change to a hand

pinching the point. Be careful not to cross the lines since you cannot drop 2

shape with crossing lines. o
e Move A Point - Hold down the left mouse button, and drag the point to

a new position. '

o Add A Point - Move the cursor over the point closest to the place you
want to add another point and click the right mouse button. Sclel{:t
Duplicate from the menu that appears. This will create a new point
between the selected point and it’s neighbor.

¢ Remove A Point - Move the cursor over the point you want to delere and
click the right mouse button. Select Delete from the menu tha_t
appears. A point may also be deleted by selecting it and pressing the
Delete key on the keyboard.

Rotating Land Shapes - Select all the points in an object and select Rotate from the
Button Bar or the Edit Menu. A square with a cross in it will appear on
the screen. This marks the spot around which all selected points will be
rotated. Move this mark by clicking it with the left mouse button, and
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drggging it to a new position. Use Ctrl + Shift + C to center the rotation
point in the middle of the work window or use the View Mesmiu. Rotate the
points by holding down the left mouse button and dragging it around the
screen. To finish rotating the points, select Rotate again. Interesting
changes can be made to a shape by selecting only some of the points before
beginning the rotate.

Oropping Land Shapes - Once the land shape is the right shape and size, it can be
added to the terrain. This removes it from the group of floating shapes and
makes it part of the land. To drop the selection, double-click inside a single
Land Shape or right click on the shape and select Drop from the menu
that appears. Land Shapes cannot be dropped if they cross themselves or
cross existing shapes in the terrain. To drop more that one object at a time,
select Drop Selected Shapes from the Button Bar or Edit Mens. This will

~ cause all shapes with any selected points to be dropped onto the terrain.

Picking Up Land Shapes - Land shapes must be picked up and made to float again
in order to edit them or duplicated and moved somewhere clse. To make
the shape float again, right click on the dropped shape and select Pick Up
from the menu that appears. Select Pick Up With Children to include all
dropped shapes positioned inside of this shape.

Use as a Shape - Dropped Land Shapes can also be used to create floating Land
Shapes that duplicate the dropped shape. Right click on the dropped shape
and choose Use as a Shape from the menu that appears. A floating Land
S}l:ape will be created that is the same shape and properties as the dropped
shape.

Shape Praperlies - To modify the shape properties, right click on the shape and
select Properties... from the menu that appears. A dialog box will then
allow you to change the texture or inflate/deflate the shape. There is also a
checkbox that will allow you to change all the dropped shapes that have
the same texture as the current shape. The texture will not become visible
until the shape is dropped onto the terrain. The textures are color-caded
indicating the playability of each texture: green (playable), red
{upplayable), and blue (unplayable, but with a free drop}. Inflating a shape

will cause the edges of the shape to move outward while deflating the
shape will move the shape edges inward.

Note: Oncg a shape is dropped, you can still change the texture type but you will not be
allowed to inflate or deflate the shape until you pick it up again. .

Note: A guick way of creating a fringe is to duplicate the fairway shape and then inflate the

d_csphc‘afe shape and change it's texture to a fringe texture. The new shape can then be reposi-
tioned over the existing fairway and dropped onto the course.

PGA Championship Golf ™ 2000 80

—Path Shapes

Select Path Shapes mode from the Button Bar or the Tools Memu. A Path Shape is
defined by a segmented line. The edges of the path run along side the central line
and squarely across the end. The sides of the path are always parallel to the central
line segment. When a path shape is dropped onto the terrain it follows the elevation
changes in the terrain. No check is made to verify that a golf cart can actually navi-
gate the path nor is the terrain leveled underneath the path.

Greate Path - Clicking the left mouse button on the Work Window will add the
starting point to the new path shape. Each mouse click will add a new
point to the path shape line. Double-click the left mouse button to add the
last point and finish the path shape. Be careful not to let the edges of the
path cross themselves or the path shape will not be dropped.

Delefe Path - Move the cursor over the path to be deleted and click the right
mouse button. Select Delete from the menu that appears. The shape may
also be deleted by selecting all the points and pressing the Delete key on
the keyboard.

Properties - The path’s shape properties can be modified by moving the cursor
over it and clicking the right mouse button. Select Properties... from the
menu that appears. A dialog box will appear which can be used to change
the texture and the width of the path. The texture will not become visible
until the path shape is dropped onto the terrain.

Note: A path shape is really only a segmented line with a texture appropriate for a cart path.
It can also be used fo create other paths such as cement sidewalks or flowerbed edging.

— Ohject Placement

Object Placement can be initiated using the Button Bar button or by selecting the
Foresting Tool in the Tools Menu. This will allow you to add objects such as trees
or rocks to the course. Once an object has been selected from the library, it will be
place on the course each time the left mouse button is clicked over the Work
Windotw. The Done button on the placement dialog must be pressed in order to fin-
ish placing objects.

Once the objects have been placed, they can be selected again by moving the cursor
over them and clicking the left mouse button. All other selections are removed and
the new item is selected. To keep increasing the number of selections, hold down the
Ctrl key while clicking on items. To deselect all objects, move the cursor away from
all objects and click the left mouse button. A rectangle may be used to select several
things at a time. To do this, move the cursor to the top left corner of the rectangular
region to be used and hold down the Shift key while clicking the left mouse button.
Now drag the cursor to the lower right corner of the selection area and release the
mouse button. To select all the objects or sounds of the same type, hold the Control
key down and double-click on an object or sound. All the objects or sounds of the
same as the one clicked on will be selected.

PGA Championship Golf ™ 2000 81



Once placed, these objects can be moved, deleted and rotated.

There are three types of objects that can be placed in the course, two-dimensional, g
Select Bhjecls - Click on the object. A wire frame will be drawn around the

three dimensional, and sound objects. Most objects are represented as two-dimen-

sional images in the course. These objects include trees, ball washers, textures, and object to indicate that it has been selected. To select all of one kind of
tflowers. Seme objects such as bridges, houses and walls must be three-dimensional. object, hold the Control key down and double-click on the desired object.
Each type of object has a unique method of placement. AlL of the objects that are the same as the object that was clicked on will

Two ﬂfmﬂﬂﬂﬂﬂ&" ﬂbjﬂﬂ’s * The two dimensional objects can be selected from

the Objects _sc-:l:ion in the Librarian. There are three ways these objects can be
placed: the Click-Click Object Placement tool, the Foresting Tool, and finally,
drag and dropping the object from the Librarian into the Work Window.

]
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Glick-Cliek Placement - Allows you to quickly place objects at specific locations on
the course. The Click-Click tool can be accessed from the Button Bar or
the Tools Menu. Choose an object type from the dialog that appears by
clicking the Object button. You can modify the settings on placed objects.
Change the height of the object by moving the slider bar until the desired
height is achieved. When placing many of a particular object it is some
times desirable to have some variation in the height of the objects. Just
choose a distance (plus or minus) that the object height can vary. You can
also change the units to facilitate placement of both small and large
objects. While this dialog is showing, you can click any where in the Work
Window to place objects. The cursor will indicate that you’re in Click-
Click object placement mode.

Foresting Tos! - When placing objects, vou may want to place many objects in an
area where the specific placement of the object is not important. Use this
to forest an area or place flowers in a flowerbed. First create and select a
Land Shape where the objects should be placed. Then choose Foresting
Tool from the Button Bar or the Tools Menu. Choose an object type from
the dialog that appears by click the Object button. The Librarian will
appear and you can choose the object you would like to place. In the
dialog you can specify the height of the object, any variation to the height,
and an average distance between the objects. Apply will populate the
selected land shape with the selected object type. This can be donc several
times if more objects are desired in the area.
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be selected. To select objects in one area, drag a selection rectangle around
the objects.

Delele Dhjects - Select the objects you wish to delete and right click on an object,
then select Delete from the menu that appears or select the objects and hit
the Delete key.

Move Dhjects - Click on the object, and then drag it to a new location.

Rolate Objeets - Select the object(s) and choose Rotate from the Button Bar or
Menu Options.

Properties - Once an object has been dropped onto the course, its properties can
be modified by right clicking the object and choosing Properties... from
the menu that appears. This will cause a dialog box to appear that is
unique to the selected item. You can modify the height of the object from
this dialog. If more than one object is selected, the Properties dialog values
will apply to all of the selected objects. The values displayed in the dialog
will be the average of all the selected objects.

Note: If the mouse cursor is moved over any entry in the Libravian and held there for a
moment, a tool-iip will appear that gives the title of that object. In the case of textures, the
tool-tip will also list whether or not a texture is playable, and if a free drop is allowed.

Three ﬂlﬂlﬂﬂﬂﬂﬂﬂl ﬂﬂjﬂb‘fﬁ * The three dimensional objects can be selected

from the Structures section in the Librarian. These are three-dimensional
renditions of objects that cannot be represented by a photo. Some of these
items are clubhouses, bridges, benches, houses, shacks and other miscellaneous
items. These objects are never placed in mass as more care needs to be given to
their placement. To place one of these structures on the course, click and hold
on one of the structures in the Librarian. Then drag the object off the librarian
and place it on the course. Once a structure is placed on the course several
things can be done to modify it’s position and orientation.

Select Structures - Click on the structure. A wire frame will be drawn around
the structure to indicate that is has been selected.

Deleie Strughires — Right-click on the structure, then select Delete from the
menu that appears or select the object and hit the Delete key.

Move Struelures - Click on the structure, and then drag it to a new location.

Rotate Struetures - Changing the orientation of the structure, so it faces a
different part of the course is simple to do. Select the structure, then
choose Rotate from the Button Bar or Menu Options.

Properties - Once a structure has been dropped onto the course, its properties
can be modified by right clicking the object and choosing Properties...
from the menu that appears. This will cause a dialog box to appear that is
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unique to the selected item. You can adjust the elevation and scale of the
structure. The elevation is useful for suspending bridges between two
points of land or putting a building into the side of a hill.

Sﬂﬂﬂﬂ ﬂﬁ]EﬂS = The sound objects can be selected from the Sound section in the

Librarian. These are sounds that should be played at specific locations. They
include sounds such as birds, waterfalls, and other ambient sounds.

Position Sounds - Click on the sound from the Librarian and drag it onto the
Work Window.
Selegt Sounds - As with Two Dimensional Objects, you can right click on a

sound to select it, drag a selection rectangle around it, or press the Control
key as you right click or double click a sound.

Properties - Once a sound has been dropped onto the course, its properties can
be modified by right clicking the object and choosing Properties... from
the menu that appears. You can change the properties for more than one
sound at once. The values in the Sound Properties dialog can be applied to
all the currently sclected sounds. The Sound Properties dialog contains the
tollowing options:

Origingl 8gund - Shows an image repre-
o senting the currently selected sound.
Fw | | If multiple sounds are selected and

Fla YT R Sl | th.ey are of different types, this option
‘—“—“j i = will be disabled,
Podon i ERRTER N e Play - Plays the currently selected
peight. [0 = 1% Agely Height ta 4l sound.
Redus: [0 = 7 Aogly Radws ol ® Stop - Stops the currently selected
sound.

C laehes O Frel & Yade

Hew Sound - When the dialog is first

i [ displayed, this button will be blank.
requency § . . : .
o G e TR TSR Press it to bring up the Librarian.
L aloinal P Aok Fecency sk Select any one of the sounds from any

.....UK c;c.:l

of the libraries and the New Sound
button will show an image represent-

ing the new sound.
¢ Play - Plays the new sound.
- ® Stop - Stops the new sound.
Posilion - Select the position and range of the sound.
¢ Height - Select the source height of the sound. This is useful for birds in
trees. Selecting Apply Height to all will move all selected sounds to this
height.
 Radius - A sound can only be heard within its specified radius. To make
a sound audible everywhere on the course, make the radius as large as
the course. Selecting Apply Radius to all will change all selected sounds
to this radius.
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Playback - Sclect the play back options for the sound.

e Loop - Sclect this check box to run a sound continuously. Selecting Apply
Loop to all will change all selected sounds to looping.

e Frequency - Control when the sound gets played. The game will check
all nearby sounds to see if they should be played. The chance that a
sound will be played ranges from 0 to 100 percent. Once a sound gets
played the game waits another couple of seconds before trying the near
by sounds again. Use the frequency slider bar to control how frequently
the sound is played. Selecting Apply Frequency to all will change all
selected sounds frequencies.

Note: When the Sound Properties dialog is first displayed and there are multiple sounds
selected, the values displayed in the dialog ave averages of the values of all the selected sounds.

— Hole Information

The Hole Definition Tool option allows you to define all of the positional informa-
tion for the 18 holes, Driving Range, Putting Green and Chipping Area. Select Hole
Definition Tool from the Tools Menu to open the dialog. Use this dialog in conjunc-
tion with the Work Window to select positions.

A hole is defined in the following order:
1. Select the hole number you want to definc.
2. Select the tee positions {all tee positions must be on a tee-box.)
3. Select the shot path for the hole.
4. Select the pin positions {all pin positions must be on the green.)
5. Create the “out of bounds” segments.”

Hole Humber - Sclect the hole number to be Site ole SR
defined. The par for this hole will be | s W\bﬂr—_ﬁ St
displayed to the right. Ll |

Briving Range / Putting Green / Chipping Area - e Lergie g

To define a Driving Range, Putting g ;n:mr:; 454 pds |
2 q . i o : i ectsional 450 pds |
(xreeg, and Chipping Area, use the hole A bl
selection arrows and move past hole 7 Ladies 370 yds
18. You will see DR, PG, or CA |V Fowesd 37 vis
| " Fin Postions

indicating that you are editing the .
Driving Range, Putting Green, and ?
Chipping Area respectively. S e el
Shot Path - The shot path is very important S _'""J__"J
to the playability of the game. It isused [(HETSSREN IR |
for lining the golfers up for each shot

| SFinPeshens definedifor hale mumber |
L Duk of Bounds

and controlling the Al golfers path to
the hole. Make sure the path is centered over the fairway from tee to hole
and avoid putting shot points on unplayable terrain. If a hole requires
golfers to hit over unplayable arcas, put a shot point just before, and one
just after the unplayable area. There is no relationship between the par of
the hole, and the number of points needed in the shot path. For example, a
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dog leg par four hole might need ten points in the shot path while a
straight shot par five might only need two. A good rule of thumb is to
always define more points than you think will be necessary for the shot
path. To define the shot path, just click once for each point that you want
to add to the shot path. The last point should fall somewhere near the
middle of the green.

Teg Positions - The Course Architect allows up to five tee positions to be defined
for each hole; Tournament (black), Professional {(blue), Amatcur {white),
Ladies (red), and Forward (vellow). The game requires that one of these
tees be defined. Select the Shot Path radio button, and then check which of
the five tee positions you want to define. Finally, place the tees in the order
that they are listed.

Pin Pasitigns - Sclect this radio button to create the pin positions for the current
hole. Any number of pin positions can be defined; there is no limit. The
game will randomly choose a position each time the hole is plaved. To
delete a pin, select it with the mouse, and hit the delete key on the key
board. To move a position, click on it with the mouse and drag it to a new
position on the green.

[ut of Bounds - Define any number of out of bounds segments per hole. Select
the Out of Bounds button and select New to create a segment. Define the
segment by clicking in the Work Window to define the area that will be
out of bounds. To create another segment simply click New again.

Instructions - Instructions are available at the bottom of the dialog. This area

will tell you the current state of the dialog and what should be entered
next.

— Gourse Perimeter

When a new course is created in the Course Architect, it encompasses an area 2000
yards long by 2000 yards wide. After creating the course, a lot of this area is
unneeded. The Create Course Perimeter option can be used to crop out all of this
unneeded area. By removing the unneeded area, the file size and memory usage will
be smaller. This will shorten load times and increase performance when the course is
played.

To crop out unused areas of the course, select the Create Course Perimeter from the
Tools Menu. Draw the new course perimeter in the same manner as a land shape is
drawn. Once the shape is completed, right click inside the shape and select Create
New Course Perimeter from the menu that appears. You will be prompted to save
the current course before the new perimeter is created.

Note: You cannot Undo this option after it bas completed.
If the newly created perimeter removes any terrain that has 2D objects, 3D objects,

or sounds on it, those objects are deleted as well. However, a new perimeter cannot
be made that leaves dropped Land Shapes outside of the perimeter.
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The course perimeter can also be made larger than the existing perimeter. This will
2dd terrain to the course, and can be useful to create more area to work in.

—Work Window

The Work Windotw is a top view of the course. It is visible at all times and can be
maximized to fill the entire application window. The contents of the Work Window
can be scrolled around and made to appear larger and smaller using the Navigation
Button Bar. All course creation work is done here including object positioning, land
shape selection, and elevation changes.

Musnen

The Work Window can be put into several Land Shape modes. Each mode corre-
sponds to a creation option that allows shapes, points _amd objects to be sele(?ted and
repositioned. The Work Window can only be in one of these modes at any given
time so selecting a mode, deselects the current mode.

There is a Status Bar at the bottom of the application window. The status bar dis-
plays some useful information such as the current mode, position, and elevation of
the course at the cursor position.

—Gamera Window

The Camera Window is used to sce the course as a golfer would. It is also useful
when verifying elevation changes made using the Tool Menu. Object and land
shapes cannot be added to this view directly but must be added to the Work
Window. The result would then be visible in the Camera Window.
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The camera icon B is associated
with a Camera Windotw that can be
moved around the course and rotat-
ed to different directions. The cam-
era can also be made to point up
and down within certain limits.

Open Window - Select Camera
Window from the Window
Mewnu or Button Bar.

Glose Window - Clicking the camera icon with the right mouse button and select
Close Camera View from the menu that appears, or click on the standard
windows icon in the upper right corner.

Position Window - While the view is open, the camera position is represented in
the Work Window by a m4 small icon. To move the camera, hold the left
mouse button down in the center of the camera icon and drag the camera
to a new location. To aim the camera, hold the left mouse button down in
the triangle lens of the camera icon and drag the cursor to the new
direction. The Camera Window will redraw after each change. If you want
to make multiple movements in the camera (such as a move, followed by a
rotate) without redrawing after each action, hold the Control key down,
make your position changes, and then let up on the key to redraw the
camera.

Propertigs - Change the elevation and pitch of the camera using the properties
dialog. To open the dialog box, right click on the camera icon and select
Properties... from the menu that appears. Use the sliders on the dialog to
change the elevation, pitch, and direction of the camera.

Genter the eamera - Hold down the Cirl key and press C to center the camera on
the Work Window or use the View Menu.

Note: When the camera is very bigh, small changes in elevation will be difficult to see in the
Camera Window. Position the camera close to the ground to see small changes in elevation.
Position the camera about nine feet off the ground to view the course as the golfer would see
it when the course is played.

—Gourse Manager

The Course Manager handles the manipulation of courses being used for PGA
Championship Golf™ 2000. The Course Manager recognizes Course files (.crs),
Course Library files (.clb), and Distribution files (xcr.)
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Use the manager to do the following operations:
Instaliation - Double-click on any one of the recognized files to launch the
Course Manager and begin installation. You can also run it manually or select
Course Manager from Course in the Game Settings screen. Then select Install.

o If the course or library is already installed, you will be prompted to
replace the existing file.

e Select the destination for the file(s) from the drive tree dialog.

o If you are installing a course or library, the files will be copied to the
destination. If you are installing a distribution file, all course and library
files will be extracted and copied to the destination. In both cases, you
can delete the original file after installation,

e The course and library lists will then be updated with your new items.

Note: You will be informed during the insiallation process if you do not bave the appropriate
libraries. You need to bave all libraries used in the course in order to finish the install.

Delefion - Highlight a course or library from the list boxes and select Uninstall.

o After prompting for approval to delete the selection, the manager will
remove the corresponding files.

e If you are deleting a course, you will have the opportunity to uninstall all
libraries that are being used exclusively by the course.

» You will be prompted to continue if you try to delete a library that is
being used by another course.

o The course and library lists will then be updated.

Maving - Highlight a course or library from the list boxes and select Move.

e Select the destination for the file(s) from the drive tree dialog.

e If you are moving a course, then all files associated with the course will
be moved to the new location. You will be prompted to move any library
files that are being used exclusively by the course.

Setting Propertigs - Highlight a course or library from the list boxes and select
Properties.

e The course properties will display a list of all libraries used by the course

and the installed size of the course. There are three edit boxes which
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display the location of additional course files. Fach course can have a
picture, a music bit, an AVI, and a rext description in addition to the
actual course and library files. You can delete the location by clearing the
edit box, or select a new location for the file by moving it manually, then
updating the text box. The file will not be copied or moved.

o The library properties will display a list of all the courses that use it and
the installed size of the library.

Packaging for Bistribufion - Package all the files associated with a course into one

distribution file. You can then send this file others.

e Highlight a course or library from the list boxes and select Compress
Files.

o Select the destination for the distribution file from the drive tree dialog.

e You will be prompted to include custom libraries in the distribution file.
Adding the libraries will make the file much larger. This is only necessary
if you believe most people receiving the file do not already have them.

o When the distribution file is complete, a notification message will appear.
Now you can distribute the compressed file and it can be installed by
others using the method described abave.

Clearing Gourse Statistics - Highlight a course from the list box and select Clear
Statistics. You will be prompted to continue, and then the statistics for that
course will be deleted. This will reset the statistics for the course.

Download additional courses - Download additional courses and submit custom
courses to the Sierra Golfing Association. Select Download to open your
web browser.

—Trouble Shooting

If there is a prablem, check these trouble-shooting methods for our suggested sofution.
o Troubleshoot — PGA Championship Golf™ 2000
» Troubleshoot — Course Architect

if probilems persist, give us a call:

e Technical Support (425) 644-4343
(see page 93 for a complete listing of all support information)
e Direct Sales Information (800) 757-7707

Trouble Shooting {Game]

Prablem: Rendering fime s very siow.

Solution 1: Decrease the window size.

Solution 2: Turn off shadows from the Machine Options screen under
Course.

Solution 3: Reduce the horizon distance from the Machine Options screen
under Course.

Solution 4: Increase the permanent course swap size from the Machine
Options screen under Coutse.

Solution 5: Reduce the terrain detail, trees and object detail, and
panorama detail on the Machine Options screen under Course.
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Problem: The quality of the scene is poor.
Solution 1: Increase the terrain detail from the Machine Options screen
under Course.
Solution 2: If the course seems too dark or light, adjust your monitor
sertings. The courses have been colored to favor average monitor
sertings.

Prablem: The goifer looks choppy during Swings.
Solution 1: Reduce the golfer detail from the Machine Options screen
under Golfer.
Solution 2: Reduce the size of the golfer by reducing the window size, or
by backing the camera further away from the golfer.
Solution 3: Close any alternate views.

Probiem: The swing cursor does nat appear for a shot in the Swing Eamera.
Solution 1: Make sure that the Continue button has been selected from the
Button Bar.
Solution 2: Make sure the game is active by clicking on the title bar.
Solution 3: Make sure the golfer that is up is a local human.

Problem: The game seems to access the GO a Iot during the game.
Solution 1: Increase the permanent course swap size from the Machine
Options screen under Course,
Solution 2: Reinstall the game using a larger install option.

Problem: The game is taking up too mueh hard drive space.
Solution 1: Reduce the permanent course swap size from the Machine
Options screen under Course,
Solution 2: Reinstall the game and choose a smaller installation size.

Problem: When piaying remate games, my connection is frequently terminated.
Solution: The game may be timing out due to a slow connection. Select
Tolerate High Latency from the Menu Options to allow slow remote
connections.

Prablem: When I try fo launch PBA Championship Golf * 2000, I receive an error message

that says, “Error Starting Program: A required D11 file, DPLAYN.DLL, was not found.”

[Note: It may aiso have DORAW.DLL or DSOUND.DLL instead of DPLAYN.DLL]

Solution: The proper version of DirectX is not installed on your system.

DirectX 6 must be installed on your computer for PGA Championship
Golf™ 2000 to run correctly. If Setup skipped the installation of
DirectX and you do not have the latest DirectX installed on your
computer, you will need to manually install it using Microsoft’s own
DirectX Setup program. To manually install DirectX, complete the
following instructions:

PGA Championship Golf " 2000 91



1. With the PGA Championship Golf™ 2000 CD in the CD drive,
double-click My Computer on your desktop.

2. Highlight the CD drive (usually D: or E:).

3. From the File Menu, select Open (double-clicking on it will launch
AutoPlay).

4., Open the DirectX folder.

5. Find and open/launch the DXSETUP.EXE file (double-click on it}.

6. Select REINSTALL DIRECTX and follow the on-screen prompts.

Prablem;: The gaifer mation skips or stufters when outdoor sounds play.
Solution 1: Reinstall the game and choose a larger install option.
Solution 2: Turn off outdoor sounds.

Problem: F'm having 2 hard lime with TrueSwing".
Solution 1: Don’t hold the mouse button down during the swing,
Solution 2: Don’t move your arm so much during the swing.

Problem: My clubs don’t seem ta hit the distances they suggest.
Solution: These are just average distances, the more a player plays, the
closer these numbers will become.

Problem: Some players can hit further than mine.
Solution: Check your Player Ability. It will affect how far you can hit the
ball.

Trouble Shooting [Architect]

Problem: The architect won’t run because it is missing a defaull texture.
Solution: Make sure you have at least one course library installed on your
machine.

Prablem: Shapes won’t drop inta the terrain.

Solution: The Course Architect requires that only one other shape enclose
each land shape. The outside land shape is called the parent shape. If
you try to drop a land shape across the edge of another shape this
would cause it to have more than one parent and the Architect will
not allow that.

Problem: The Gourse Architeet will not run.

Solution: If the Course Architect begins to load and then quits back to
Windows it most likely that you have not installed the course libraries
correctly on your machine. It is also possible that a library is installed
that does not support the basic rough, fairway, and fringe textures.
Reinstalling the Course Architect will fix the problem.

Problem: A new architect course has poor performance.

Solutionl: Optimize the detail in areas that are rarely seen in the course.
Solution2: Decrease the size of the course perimeter.
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Problem: The players face the wrong direction when playing an architect course.

Solution: Make sure the shot path was defined correctly in the whole
information,

—Technical Support

Sierra Support Numbers and Addresses

Technical Support

Sierra On-Line offers a 24-hour automated technical support line with recorded
answers to the most frequently asked technical questions. To access this service, call
(425) 644-4343, and follow the recorded instructions to find your specific topic and
resolve the issue. If this fails to solve your problem, you may still write, or fax us
with your questions, or contact us via our Web site,

Technical Support - United States

Sierra On-Line

Technical Support

IO, Box 85006

Bellevue, WA 98015-8506
http://www.sierra.com support@sierra.com

Phone: (425) 644-4343
Fax: (4253) 644-7697
Monday-Friday 8:00 a.m. - 4:45 p.m. PST

Havas Interactive offers a 24-hour Automated Technical Support line with recorded
answers to the most frequently asked technical questions. To access this service, call
(0118) 920-9111, and follow the recorded instructions to find your specific topic
and resolve the issue. If this fails to solve your problem, you may still write, or fax
us with your questions, or contact us via our Internet or CompuServe sites.

Technical Support - Upited Kingdom

Havas Interactive

2 Beacontree Plaza Main: (0118} 920-9111

Gillette Way (Monday-Friday, 9:00 a.m. - 5:00 p.m.)
Reading, Berkshire Fax: (0118) 987-35603

RG2 0BS United Kingdom

http:/fwww.sierra-online.co.uk

Support Teehnigue - Frange
Havas Interactive

Parc Tertiaire de Meudon Téléphone : 01-46-01-46-50
Immeuble “Le Newton” (Lundi au Jeudi de 10h 4 19h
25 rue Jeanne Braconnier Vendredi de 10h a 18h)
92366 Meudon La Forét Cedex Fax : 01-46-30-00-65

France

http:/fwwwi.sierra. fr

Technical Suppart - Germany
Havas Interactive
Robert-Bosch-Str. 32

Phone: (0) 6103-99-40-40
(Montag bis Freitag von 9h - 19Uhr)
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D-63303 Dreieich
Deutschland

http:/fwww.sierra.de

Fax: (0) 6103-99-40-35
Mailbox (0) 6103-99-40-35

Servicio Tecnico - Spain

Havas Interactive Tel: (01) 383-2623

Avenida de Burgos 9 (Lunes a Viernes de 9h30 a 14h y
1°-OF2 de 15h a 18h30)

28036 Madrid Fax: (01) 381-2437

Spain

Modem Support

CompuServe United Kingdom:
CompubServe France:
CompuServe Germany:
Interner USA:

Internet United Kingdom:
Internet France:

Internet Germany:

GO UKSIERRA

GO FRSIERRA

GO DESIERRA
http:/fwww.sierra.com
http:/fwww.sierra-online.co.uk
htep:/fwww.sierra.fr
htep:/fwww.sierra.de

— Direct Sales Information

Sierra Support Numbers and Addresses

Direct Sales / Information
U.S. Direct Sales
Sierra Direct

P O Box 629001

El Dorado Hills

CA 95762-9972

U.S.A. Sales (800) 757-7707

Hours: 24 hours a day, 7 days a week
International Sales (425) 746-5771

(916) 939-1010 (fax)

Hours: Monday-Friday 8AM to 4PM PST

Direct Mail - United Kingdom
Havas Interactive

2 Beacontree Plaza,
Gillette Way

Reading, Berkshire

RG2 0BS United Kingdom

Main: (0118) 920-9111
Monday-Friday, 9:00 a.m. - 5:00 p.m.
Fax: {0118} 987-5603

Disk/CD replacements in the UK. are £6.00, or £7.00 outside the UK. Add “ATTN.: Returns.

Vente par correspondence - France
Havas Interactive

Parc Tertiaire de Meudon
Immeuble “Le Newton™

25 rue Jeanne Braconnier
92366 Meudon La Forét Cedex
France

Téléphone: 01-46-01-46-50
Lundi au Jeudi de 10h & 19h Vendredi de 10h 4 18h
Fax: 01-46-30-00-65
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Direktversand - Germany
Havas Interactive
Robert-Bosch-Str. 32
D-63303 Dreieich
Germany

Dn-Line Sales

CompuServe United Kingdom:

CompuServe France:
CompuServe Germany:

Internet USA:

[nternet United Kingdom:
Internet France:

Internet Germany:

Phone: (0) 6103-99-40-40
Montag bis Freitag von 9h - 19Uhr
Fax: (0) 6103-99-40-35

GO UKSTERRA
GO FRSIERRA
GO DESIERRA

http:/fwww.sierra.com
http:/fwww.sierra-online.co.uk
http:/fwww.sierra.fr
http:/fwww.sierra.de

The Sierra NO-RISK Guarantee

The Promise: We want you to be happy with every Sierra product you purchase
from us. Period. If for any reason you're unhappy with the product, return it within
30 days for an exchange or a full refund... EVEN IF YOU BOUGHT IT RETAIL.
(Hardware ordered direct must be returned within ten days.) Please send back your
product, signature required if mailing via US Postal Service.

The Only Catch: You've got to tell us why you don’t like the game. Otherwise, we'll
never get any better. Send it back to us and we promise we will make things right.
(If you bought it at a retail outlet, please send your original sales receipt.)

U8 Disk/Boco Repiacement & Returns [Valid in North America Only)

Wigk/Doco replacement:
Havas Interactive

Sierra On-Line Fulfillment
4100 West 190th Street
Torrance, CA 90504

Product Returns:

Havas Interactive
Sierra On-Line Returns
4100 West 190th Street
Torrance, CA 20504

NOTE: To replace your disk(s} please send only Disk #1 {or the CD} and copy of your dated
receipt, if less then 90 days. After 90 days please include a $10 bandling fee along with Disk /
D i1, For Documetaion, please include a $ 5.00 handling fee and a photocopy ONLY of
disk W1, Payment should be made at the time of your requst. Sorry, no credits cards.
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Dale Deputy
Team Lead, Software Engineer, Game Engine,
ReadyPlay™, Commentary and Motions, Season Play

— International Support

Sierra Support Numbers and Addresses
International Support Services

Nathan B. Hall
Designer, Software Engineer, Al, Statistics, Real-Time
Ball, Animation Engine, Localization, Manual Writer

Infernational Sales

Sierra Direct For direct orders: Brad Worthen

7100 W. Center Rd Main: (425) 746-5771 Software Engineer, Interface,

STE 301 Omaha NE 68106 Fax: 402-393-3224 Course Architect New Course Tools

Uinited Kingdom Matt Peterson

Havas Interactive Customer Support: {0118) 920-9111 Interface Design, 2D Course Art, Photographer,
2 Beacontree Plaza Monday-Friday, 9:00 a.m. - 5:00 p.m. Sound Technician

Gillette Way Fax: {0118) 987-5603

Reading, Berkshire
RG2 0BS United Kingdom Scott Ferrin
Course Creator, 3D Course Structures

DiskiCD replacemenis in the UK, are £6.00, or £7.00 outside the UK. Add “ATTN: Returns™.

France Mitch Stevens

Havas Interactive Téléphone : 01-46-01-46-50 Art Lead, Golfer (Model, Textures, Animations), Photographer
Parc Tertiaire de Meudon Lundi au Jeudi de 10h a 19h Vendredi de 10h a 18h

Immeuble “Le Newton™ Fax : 01-46-30-00-65

25 rue Jeanne Braconnier Brian Copfer

92366 Meudon La Forét Cedex Concept Art, World Designer
France

Germany

Havas Interactive Phone: (1) 6103-99-40-40

Sierra Coktel Deutschland Montag bis Freitag von 9 - 19Uhr Jason Howard
Robert-Bosch-5tr. 32 Fax: (0} 6103-99-40-35 In House Testing, Installation
D-63303 Dreieich

Germany

Andy Hoffman

— E’I Ed"s In House Testing

Quality Assurance Manager Gary Stevens
Developers - PGA Championship Golf * 2000 QA Casual Games Supervisor Laurel Randall
Lead Test Engineer Dayna Smith
QA Testers Dave Carter, Cullen Faugno,
Vance Cook Sonya Rhen, Dave Thomas
Director
Additional Artists Brian Jones, Lori Bawden

Michael D. Jones
Software Engineer, Course Creation, TrueSwing”™,
Golfer Rendering, Course Rendering
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Additional Gredits

Sr. Producer
VP of Development

Digital Video Director
DV Specialist

Brand Manager

St. Creative Services Manager
Sr. PR Manager

Box Design

Motion Capture Dept Head & Tech Director

Motion Capture Director
Motion Capture Editing

Motion Caprure Male Talent
Motion Caprure Female Talent

WON Programming

Music and Sound Effects
Sound Effects

Golf Commentators
Voice Talent

Intro Video Talent
Recording Studios
Video Content

Manual Writing
Manual Editing

Manual Design and Layout

Commentary Script Writing
Course Intro Writer

Mike Jacob

Steve Van Horn

James Carey
Kate Alley, Steve Bradford,
Sage Freeman

Justin Kubiak

Kevin Lamb
Michelle Stephens
Moore Design Group

Troy McFarland

Kari St. John

Shannon Holder, Tom Van
Velkinburgh, Jackie Hailey, Bailey
Tien,Brian Wright, Nathan Smith,
Sienna Chastain, James Franssen
Jim Jones

Kate Kloos

Doug Leary, William Bonner,
David Ruf, Len Skiena, John
Petrick, and other Fabulous
Engineers at WON

Chuck Barth

Ken Rogers, Jon Davie,

Craig Utterback

Mark Lye, Grant Boone

Bill Barrett, Geoff Spade, Michele
Wilson, Mike Stalker, Mark
VanWagoner, Deb Adams,
Sam A. Mowry

Justin Kubiak

REX Recording & Video Post,
ASC Media

Quicksilver Studios

Nathan Hall
Lawrence Russell
{The Russell Group)
Gene Shands

Mike Jacob, Mark Lye
Chris Lanier
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Golfer Models

Course Architect Design Consultants

Design Suggestions

Gallery Models

Photographers

Coeur d'Alene Course

T'he Pete Dye Golf Club

The Prince

The Royal Birkdale Golf Club

Suhalee Country Club
Pasatiempo

Zygote Media Group, Inc.

Steve Opfer, Kenneth A. McHale,
Scott Chesney, Brian Silvernail,
Jeffrey Jones, Jeremy Silva,

Jim Crittenden, Tavlor Anderson,
Jim Dickson

Mike Jacob, Justin Kubiak, Pablo
Peromingo Manso, Eric Jennings,
Jeremy Jones

Bob Boyle, Vance Cook, Brian
Copfer, Dale Deputy, Nathan
Hall, Dusty Hanks, Holly Hanks,
Andy Hoffman, Jason Howard,
John Howard, Matt Howard,
Vickie Howard, Brad Jessey, Amy
Jones, Mike Jones, Debi Mathis,
Wade Mathis, Cher Passey, Laura
Payton, Dixiec Simonson, Mitch
Stevens, Brad Worthen, Mike
Jacob, Michelle Stephens, Jeremy
Jones, Robert Bakie, Neeraj
Murarka, Dave Carter, Sonya
Rhen, Dayna Smith, Steve Chin,
Missy Castro, Doug Van Horne,
Steve Navarro, John Vechey, Ross
Perez, Sue Ung, Steve Messick,
Regan Lindstrom, Janelle Watts,
Kelly Stanmore, Ron Lassen,
Christopher A. Floyd, Thamer
Abanami, Steve Epstein, Heidi
McCory, Rabih Abourjaoude,
Craig Utterback, Mike Kihara,
Sean Stephens, David Thomas.

Brad Hagadone

Brian Morgan, Ken E.May
Doug Peebles, Paul Barton
Brian Morgan,

Christopher John Photography
Matt Peterson, John Johnson
Matt Peterson
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Videagraphers

Sahalee Country Club Steven Bradford
Pasatiempo Golf Club Thomas Myrdahl
Eourses

® The Princeville Resort was provided by and used with permission from
Starr-Seigle-McCombs and The Princeville Resorts.

* The Pete Dye Golf Club was provided by and used with permission from the Pete
Dye Golf Club.

* The Coeur d’Alene was provided by and used with permission from The Cocur
d’Alene Resort Golf Course.

* The Pasatiempo Golf Club was provided by and used with permission from
Pasatiempo Golf Club.

e The Black Diamond Ranch Golf & Country Club was provided by and with per
mission from the Black Diamond Ranch Golf & Country Club.

® The Royal Birkdale Golf Club was provided by and used with permission from
The Royal Birkdale Golf Club Merchandising Company, Ltd.

® The Sabalee Country Club was provided by and used with permission from the
Sahalee Country Club.

* The Jocassee Shoals was provided by and used with permission from Jim Dickson.

* The Canaveral Dunes was provided by and used with permission from Brian
Silvernail.

® The Cabo del Diablo was provided by and used with permission from Brian
Copfer.

® The Gloucester Golf and Hunt Club was provided by and used with permission
from Steve Opfer.

* The Monterey Shores Country Club was provided by and used with permission
from Ken McHale.

* The Whisperwood Golf Club was provided by and used with permission from Jim
Dickson.

Family and Friends
A special thanks goes to the families and friends of the developers who have sup-
ported them and patiently endured their absence:

Kim Cook, Marvin Copfer, Tricia Copfer, Julie Ferrin, Amy Jones, Debi Mathis,

Wade Mathis, Paul Muniz, Kristin Peterson, Susan Sheets, Brenda Stevens, Denise
Stott, Angie Worthen
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Call 1-800-757-7707 or visit your local retailer today. See our Web site at www.sierrasports.com.
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